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Dedication

This guide is dedicated to our students, past and present.  We have learned and continue to learn a great deal from them.  They inspire us with their enthusiasm, curiosity and their openness for learning.  We will be adding stories in sections where students played a particular role in our learning process.  

Students who are visually impaired have the same needs as other students. They want to feel successful and proud of their work as much as any other student.  When students with a visual impairment have access to computers and notetakers on school campuses and in classrooms the opportunities for their success are increased tremendously.  What follows is one of Joan’s stories about a student and her notetaker.
A former student had lost her vision when she was in first grade.  She was adjusting to her vision loss and learning to use braille as her primary reading medium.  I will never forget what I witnessed when I watched her the next year in her second grade classroom.  She was finishing her language arts assignment using a nifty little braille notetaker.  Nothing warmed my heart like watching her from across the room independently print and turn in her assignment.  The joy on her face as she searched the “done box” and realized it was empty, created an unforgettable memory.  She hadn’t been first to turn in her paper since losing her vision.  Her quiet exuberance as she celebrated a private victory provided an extraordinary moment.  It’s those moments that strengthen teachers in their continued efforts to make a difference in the lives of our students.  Assistive technology played a key role in that moment.
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INTRODUCTION

This basic guide is designed to train teachers in the fundamental commands needed to use the Braille Note for creating, editing, and printing documents in any application.  Since the majority of teachers of the visually impaired are sighted, this guide is written with the commands for speech output.  The braille display is difficult to read visually.  It often helps to tilt the Braille Note up to a 45-degree angle when using your vision to read the braille display.  Passing your finger over the display before reading it visually will clear any dots that may be stuck in the up position.  Keep in mind, when teaching braille reading students, they will likely prefer to use the thumb keys to navigate and read directly off the braille display.  Once braille students become familiar with the Braille Note, they generally turn the speech off or use the speech on request option.  

We will begin with the design of the Braille Note.  This guide is meant to be user friendly and is constantly being revised.  It is being shared with you in the hopes that if you discover errors, an unclear passage, or have suggestions for improvements, that you communicate your ideas with the authors.  Feel free to share it with others as long as the footer remains intact.  If you obtain this guide but do not have a copy of the files to use with it, please contact us at the California School for the Blind, 510-794-3800, and we will be happy to e-mail them to you.  You can also check our web site www.csb-cde.ca.gov for updates to the guide or for the exercise files.
When using this guide, anything written in italics refers to the speech output of the Braille Note when a command is entered.

***** IMPORTANT RULES for every student and teacher to understand:

1. Always backup files on a separate floppy disk or storage card.

2. Never save documents on the KeySoft System Disk.  
Documents saved on the KeySoft System Disk will be erased when the Braille Note is reset.  
I suggest every student purchase a storage card and use it regularly to back up important files.  Details for how to use and where to obtain storage devices will be found later in this guide.  

First Letter Navigation

First letter navigation enables the user to quickly select a menu item.  For example, in the main menu if you press the letter w, you go directly to the word processing (Keyword) menu.  If you press the letter f, you go directly to the file manager menu.  First letter navigation commands will be used throughout this document.  When instructing students, you may want to have them navigate through the menus initially using the third and second thumb keys until they become familiar with the items in each menu.  

Choices and Context Oriented Help

The Braille Note will often give you a choice in a menu, such as print or setup printer?    or ask a question that requires a response, “Is the printer ready?”.  A response is required to any prompt that is a question.  Generally speaking, pressing the first letter of the choice you want will select that option.  For example, press P for print or S to setup the printer.  It is a good practice to press Y for yes and N for no although the enter key works for a Yes response when the Braille Note queries “Is the printer ready?” 

Sometimes there may be several choices and the Braille Note does not make suggestions.  In this case, you can Press H with the space bar to use Context Oriented Help when you are uncertain what to do.  The Help Lesson (see Table of Contents) contains more information on built-in help.  

Lesson 1 – BRAILLE NOTE DESIGN
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The Braille Note keyboard is ergonomically designed with a:

Six-Key Braille Keyboard with a Space Bar

Backspace Key (the left baby finger key) - moves back an item in a menu or list, exits a menu at the top of the menu or when in the word processor or other applications, erases the previous cell.

Return Key or Enter Key (the right baby finger key) 
There are also four thumb keys:

Far Left Thumb Key is the Previous Key or what we refer to as Thumb Key 1 – exits the current operation or menu or when in the word processor or other application, goes up one line.
Middle Left Thumb Key is the Back Key or what we refer to as Thumb Key 2 – goes back through a menu or when in the word processor moves the braille display back one width - 32 cells or 18 cells depending on your unit. 

Middle Right Thumb Key is the Advance Key or what we refer to as Thumb Key 3 - goes forward through a menu or when in the word processor advances the display one width - 32 cells or 18 cells depending on your unit. 

Far Right Key is the Next Key or what we refer to as Thumb Key 4 – selects the next item in a menu or enters your entry at a prompt, (similar to the return key) or when in the word processor or other application, moves the display down one line.
The braille display itself is made up of 8 dots per cell to accommodate computer braille as well as to provide indicators for the cursor location or screen attributes.  Above each cell on the braille display are cursor routing switches which move the cursor to the cell you've selected.  

Commands may be initiated by holding down the “spacebar”, “backspace” and/or “enter” keys simultaneously with other keys.  Most of these key combinations are “mnemonic” and represent the command with the first letter of that command for launching the application or initiating the action to be taken.  

When you turn on the Braille Note (BN), you are placed in the same place you left off.  

For example: Resuming KeySoft, main menu or Keyword, resuming edit of ____ (file name).  The message you hear will depend on where you left off when you turned the Braille Note off or where it was when it went to sleep.  It is a good practice to have students exit to the main menu (all six braille keys with the space bar will always take you to the main menu) when they are finished working for the day.  If the battery completely drains before the Braille Note is used again, any information that was last input will be saved if this practice is followed.  
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Turn the Braille Note around so that the back is facing you and explore the ports on the back panel.  When looking at the back the window on the far left is the infrared port.  This port can be used to print to an infrared enabled printer or embosser.  It can also be used as the connection device to a computer or Palm Pilot with an infrared port for file exchange or synchronization.  On the right side of the infrared port is the rj11 telephone line connection to the internal 56k modem for internet dial-up and e-mail service.  On right side of the rj11 connector is the parallel port for connection to an embosser or ink print printer.  On current products, the next port to the right is the compact flash card slot that is used for network access to the Internet or compact flash memory cards.  On the right of the compact flash card slot is the serial port that can be used for serial connection with an embosser, printer, a Palm Pilot as a visual display, the computer for the visual display or the active sync program, or a GPS receiver.  The last connector on the back is the AC Adapter socket that is used when the Braille Note needs recharging.
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The right side of the Braille Note contains the PCMCIA (PC Type2 card) slot that is used for inserting a memory card, a low voltage ethernet card or the Super Disk Drive.  If using Compact Flash memory cards or ethernet cards, you will need a PC Card Adapter as well.  Storage devices in either the PCMCIA slot on the side or the compact flash card slot on the back are used for copying and transferring files to and from other devices and may also be used to back up files stored on the Braille Note.  You should always back up files on a separate storage device.  If the flash disk “hard drive” of the Braille Note crashes you will lose all data, but hopefully you’ve recently backed up your files to a memory card or floppy disk.  Backing up files to the flash disk itself should NEVER be done.  In fact, all files should be created and saved on the flash disk or a storage card.  NEVER save or backup files on the KeySoft system disk.  Why? When you reset the Braille Note, files saved on the KeySoft system disk will be erased and the operating system can be corrupted.  
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The left side of the Braille Note contains a recessed reset button, the power button and the earphone jack.  

Lesson 2 - SPEECH SETTINGS

Turn the unit on.  On the left hand side of the unit, there's a rocker switch, press toward you and the unit will turn on and speak.  You can change the speech settings at any time in the Braille Note.  The enter key must be pressed and held down while tapping another key to effect the speech.  The commands are:

Press dot 1 with the enter key for softer speech.

Press dot 4 with the enter key for louder speech.

Press dot 2 with the enter key for a lower pitch.

Press dot 5 with the enter key for a higher pitch.

Press dot 3 with the enter key for slower speech.

Press dot 6 with the enter key for faster speech.

Some students who prefer to use only the braille output without speech, like to turn the speech off altogether.  To do this, hold the space bar down while simultaneously pressing the first thumb key.  It cycles through three choices:


Speech On


Speech on Request


Speech Off

Likewise if a student accidentally turns off the braille display, it can be turned on again by holding the space bar down while simultaneously pressing the fourth thumb key.  It cycles through two choices:


Braille On


Braille Off

Lesson 3 - EXPLORING THE MENUS

The Braille Note runs in a Windows CE environment and is similar in nature to how your computer works.  The Braille Note has a main disk called the Flash Disk.  It is comparable to the C-drive on a computer.  

There are 3 levels on the Braille Note:


The Disk Level



The Folder Level




The File Level

All Braille Notes have a Flash Disk, a KeySoft System Disk, and Storage Card Slot.  Newer machines also have a Compact Flash Card Slot.  These additional slots allow for added memory devices and other peripherals to greatly expand the capability of the machine.   You may only create "folders" and "files" on the Braille Note.  You cannot create directories and sub-directories.  The disk levels and slots for the Braille Note are described below:  

Disk Levels

Flash Disk


Folders that come with the Braille Note



Dictionaries

Downloads

General

KeyList
KeyMail
KeyPlan
My Books



My Favorites

KeySoft System Disk – Do not save on the KeySoft System Disk


Folders that come with the Braille Note



Books

Dictionaries

KeySoft
Manual



Printers



Temp


Windows

Storage Card Slot

Compact Flash Card Slot 
The Main Menu is similar to the Start Menu on a PC Computer.  It has sub-menus for most of the choices.  They are listed below.  Some sub-menus also have menus but they will not be listed.  

The Main Menu:


Word Processing


Planner



Address List


E-Mail


Internet


Media Player

Book Reader


Scientific Calculator


** GPS (optional program)


File Manager


Utilities


Terminal for Screen Reader


Remote Synthesizer


Keyboard Learn


For Information press space with I


For the Options menu press space with O anywhere

Sub Menus for Word Processing:


Keyword Menu



Create a Document


Open a Document



Emboss a Document


Print a Document



Setup Options

Sub Menus for Planner:


KeyPlan Menu




Open Planner


Emboss Planner



Print Planner


Setup Options

Sub Menus for Address List:


Key List Menu



Add Address



Look Up Address



Copy Addresses



Emboss Addresses



Print Addresses



Select Key List File



Free Data Base space 

Sub Menus for E-mail Menu:


KeyMail Menu



Write an E-mail



Read E-mail



Connect to a Service



Set-up Options

Sub Menus for Book Reader: no Sub Menu

Scientific Calculator: no Sub Menu

Sub Menus for File Manager:



Directory



Copy File


Erase File



Rename File


Move File 

Protection



Translate File


Folder Manager

Sub Menus for Utilities:



Connect to Active Sync



Synchronization

Backup or Restore Files



Pronunciation Dictionary



Date and Time Set



Application Program



Miscellaneous Options



Key Management

Terminal for Screen Reader – no sub menu

Remote Synthesizer – no sub menu

Keyboard Learn Mode – no sub menu

Information – copyright info – no sub menu

The Options Menu

Another useful menu is the options menu.  You may enter this menu from any point in any application or function in the Braille Note.  Press O (dots 1,3,5) with space to enter the options menu.  Your menu choices will change depending on the application you’re in when you’ve entered the options menu.  Exiting out of the options menu can sometimes happen immediately after you have made your choice.  For example when checking the battery level, press o with space followed by the letter P, the Braille Note will respond with the percentage of power remaining and immediately place you back where you were without another key stroke.  However, when you enter the options menu and press V to go to the Visual Display option, you must make a choice in order to change the communication port for the visual display.  Press enter to select the appropriate choice.  

Here are the items in the Options Menu:


Date 

Time Options


Grade of Braille for Keyboard Entry


Braille Display Options


Keyboard Settings


Review Voice


Visual Display


Next Appointment


Power and Battery Status


User Guide


Insertion 


Spell. Repeat and Spells file names or anything that the cursor is on


Hear Punctuation



Change Task


Front Thumb Keys


To Speak Louder Press Enter with Dot 4


To Speak Softer Press Enter with Dot 1


To Speak Faster Press Enter with Dot 6


To Speak Slower Press Enter with Dot 3


To Increase Speech Pitch Press Enter with Dot 5


To Decrease Speech Pitch Press Enter with Dot 2

Things to Consider Adjusting in the Options Menu 

Within the options menu, there are many user adjustable settings that effect how the Braille Note displays information in braille or speaks information and prompts to the user.  One can check the status of battery power, tell the time and date or change the responses of the keyboard in the Options Menu.  We recommend that you and/or your students thoroughly explore the options available to find the most efficient way of setting up the Braille Note.  We have found that the following settings are useful with regard to the braille display and keyboard voice.  

Changing the Braille Display Options

Within the options menu, some choices change depending on what application you are in when entering the options menu.  For example: When in a document in KeyWord, KeyPlan or the Book Reader, you can change the "braille display options" item "show new lines in reading mode as" linear braille format, the factory default.  In this format a $p is used as a separation marker to indicate the beginning of a new line.  New paragraphs are indicated by the use of 2 $p symbols.  Most students prefer a 2 space indent at the left margin of the braille display to show the beginning of a new paragraph which is similar to indentations at the beginning of paragraphs in hardcopy braille materials.  Other braille presentation formats are available as well in this option.  However, none of these braille reading format choices are available from the Main Menu or KeyList application.  

To change the braille display to indicate a paragraph with a 2 space indent, follow these steps:

From within a KeyWord Document, press space with O (dots 1,3,5) Options Menu 
Press B- Braille On – Currently Yes
Then press the space bar twice to get to show new lines in reading mode as …

press b for indent 2 cells 
to return to linear format press l

Press the Enter Key to execute the command (you will then be at the next item in the options menu) 

Now exit the Options Menu by pressing space with E (dots 1,5).

You will then return to your open document.

When in doubt, press space with h for context oriented help.

Changing the Keyboard Voice 

From anywhere, press space with O (dots 1,3,5) Options Menu 
Press K – Keyboard Voice currently …

Your choices are:


B – both words and spell



F – off 



S – Spell

W – Words

Make your selection and press the Enter Key to execute the command (you will then exit the Options Menu and return to your last location

Movement Through Menus

You can move down through a menu by pressing dot 4 with space, the space bar, or Thumb Key 3. You can move up through a menu by pressing dot 1 with space, the backspace key or the Thumb Key 2.  To move quickly to the menu you want, press the first letter of that menu.  For example, from the Main Menu, the letter w will take you directly to the "KeyWord Menu," the Word Processing Menu.  
To enter a menu, press the Enter Key (right baby finger) or Thumb Key 4 (farthest to the right).  You may also select your choice from a menu by pressing one of the cursor routing switches above that menu item.  To escape out of a menu, press e (dots 1,5) with space or press Thumb Key 1 (farthest to the left).

Now let's explore the menus.  

Lesson 4 – OPENING A DOCUMENT

We will now open the Navigation Document.

From the main menu, (all six braille keys with space) – main menu

Press w for the word processor key word menu
Press o folder name, press enter for ____ (your name).  Press enter to open your folder.   
If for some reason your name does not appear and you want to view the list of folders you must first press the space bar or the third thumb key and a list of folders will appear.  There are several ways to find folders in the list:

· Teachers who are sighted generally press the space bar to go through the list one folder at a time until they hear the name of the folder they want and then press enter.  The folders are listed in alphabetical order.    

· If you want to quickly go to a folder, such as the general folder, you can use first letter navigation by pressing “g” until you hear general and choose it by pressing the enter key.

· Braille display readers will likely use first letter navigation or the third thumb key to search for their folder and the enter key or the fourth thumb key to select it.  

Once you’ve selected your folder, you must now choose the file you wish to open.  

document to open press enter for ____ (file name).

As you searched for your folder, you may now use the same technique to search for your file.  i.e. press “n” until you hear navigation and press enter.

Top of document “Today”

If you are not at the top of your document, press space with dots 1,2,3.  Read through the document first by pressing g with the space bar, the Braille Note will read the document continuously.  You may stop the speech at any time by pressing the Enter and Backspace keys simultaneously.  Go back to the top of the document, dots 1, 2, 3 with space and begin reading it again using the character, word, sentence and paragraph reading commands.

Navigation

Today we will be working with the Braille Note.  I shall learn enough to begin to teach its basic functions.

This exercise will help me learn to navigate through documents.  My right hand will move the cursor forward and my left hand will move the cursor backward.  Amazingly, if I use both hands at the same time, the cursor will not move and I will hear the current character, word, sentence, or paragraph.

The thumb keys are used to navigate while reading with the braille display.  They may also be used to navigate and select menu items.

The switches above the braille display may be used to route the cursor.  Try it, you'll like it!  Just press a switch and watch dots 7 and 8 pop up under a character or space.  This is the last line of this document.

Lesson 5 - Navigation

Navigation Commands 

The commands for maneuvering around a document are very logical and sequential. The commands performed on one side of the keyboard will have an equal and opposite effect when performed on the other side.  For example, for commands performed on the keys on the right hand side, the device will speak and move the cursor in a forward direction.  For commands performed on the keys on the left hand side, the device will speak and move the cursor in a backward direction.  For commands performed simultaneously with the keys on both sides, the device will speak and keep the cursor at its current position. 

dots 1,2,3 with space will take you to the top of document

dots 4,5,6 with space will take you to the bottom of document

For those of you who are familiar with the Braille ‘n Speak/Braille Lite line of products, many of the commands that are used with those products are similar or identical with the Braille Note commands.

Reading with Speech Commands

Reading Continuously 
Press g with space (dots 1,2,4,5 with space) to read continuously. 

You can stop reading by pressing the backspace with the enter key and the cursor will stop close to what you just heard.

Reading Paragraphs

Dots 2,3,5,6 with space - keeps the cursor on the current word & reads the present paragraph 

Dot 5,6 with space - moves the cursor forward to the first cell of the next paragraph & reads that paragraph

Dot 2,3 with space - moves the cursor backward to the first cell of the previous paragraph & reads that paragraph

Reading Sentences

Press dots 1,4 with space  - keeps the cursor at its present position & reads the current sentence

Dot 4 with space - moves the cursor to the beginning of the next sentence & reads it

Dot 1 with space - moves the cursor to the beginning of the previous sentence & reads it

Reading Words

Dots 2,5 with space - keeps the cursor on the present word & reads it

Dot 5 with space - moves the cursor forward a word & reads it

Dot 2 with space - moves the cursor backward a word & reads it

Reading Characters

Dots 3,6 with space - keeps the cursor on the present character & reads it

Dot 6 with space - moves the cursor forward a character & reads it

Dot 3 with space - moves the cursor backward a character & reads it

Note: When reading words, if the command is pressed twice, the word will be spelled in expressed in contracted braille.  For example, the word working will be spoken “dot 5 w ing”.  When dots 2,5 with space is pressed a third time, the word will be spelled out letter by letter, w o r k I n g.   When reading characters, if the command is pressed twice, a sound clue word will be given using the army call letters.  For example, if the student cannot understand if he wrote the letter t or the letter d, when you read the 

character by pressing dots 3,6 with space twice, the Braille Note will respond “tango” for the letter t, and “delta” for the letter d.

**** IMPORTANT RULES for every student and teacher to understand:

The cursor moves when:

reading with speech commands

when you used the cursor routing switches

When reading in braille with the thumb keys, THE CURSOR DOES NOT MOVE.  It is necessary to "route" the cursor to the word at your fingertips with the switch above the cell before editing.  
Reading with the Braille Display

When reading the braille display, one's thumbs are positioned in front of 4 thumb keys.  The basic functions of these keys may be re-assigned to other thumb keys to accommodate reading styles of left handed, right-handed, or one handed braille readers.  Read the manual to change these settings, 5.4.14, Thumb Key Set.  Using the factory default settings, these keys perform the following functions: 

Thumb Key 1, move up one line

Thumb Key 2, move back one display width

Thumb Key 3, move forward one display width

Thumb Key 4, move down one line 

Remember, the speech cursor does not move when reading with the braille display controls and therefore must be routed to the cell immediately to the right of where you wish to make a change in your text. 

Auto-scrolling with the Braille Display

The display may be scrolled automatically to encourage students to read faster.  It can also be used as a tool to defeat "scrubbing" and/or other inappropriate braille reading behaviors.

Press space with dots 1,2,4,5,6 to automatically scroll forward in the entire text on the braille display.  To speed up the scrolling speed, press the thumb key 4, to slow down the scrolling speed, press the thumb key 1 and to stop scrolling, press backspace with enter.  

Navigating Through Menus

Navigating through menus is similar to navigating through a document.  You can navigate using the thumb keys one item at a time.  The third thumb key goes forward through the menus and the second thumb key goes back through the menus.  The fourth thumb key selects a menu item and the first thumb key escapes back one menu level.  

Lesson 6 – Create a Document

To create a document:

Start from the main menu, press all six braille keys with space - main menu

Press w for the word processor KeyWord menu 
Press c folder name, press enter for ____ your name (the last folder used will appear)  Press enter to open your folder.   
If for some reason your name does not appear and you want to view the list of folders you must first press the space bar or the third thumb key and a list of folders will appear.  There are several ways to find folders in the list:

· Teachers who are sighted generally press the space bar to go through the list one folder at a time until they hear the name of the folder they want and then press enter.  The folders are listed in alphabetical order.    

· If you want to quickly go to a folder, such as the general folder, you can use first letter navigation by pressing “g” until you hear general and choose it by pressing the enter key.

· Braille display readers will likely use first letter navigation or the third thumb key to search for their folder and the enter key or the fourth thumb key to select it.  

Document to Create?  

Write the word practice and press enter.

Top of Document Blank

Now you have a blank document.  We are going to practice writing a few sentences.  First write your name and the date at the top of your paper and press enter.  The enter key acts like a return key when working in the word processor.  Then write at least one sentence about yourself that’s unique.  If you make a mistake and hear that you did, press the backspace key to correct it and continue writing.  
 Lesson 7 – Easy Edit

What follows is a review of opening a file.  Let’s open that Easy Edit Document and practice editing.  

From the main menu, (all six braille keys with space) – main menu

Press w for the word processor key word menu
Press o folder name, press enter for ____ (your name).  Press enter to open your folder.   
If for some reason your name does not appear and you want to view the list of folders you must first press the space bar or the third thumb key and a list of folders will appear.  There are several ways to find folders in the list:

· Teachers who are sighted generally press the space bar to go through the list one folder at a time until they hear the name of the folder they want and then press enter.  The folders are listed in alphabetical order.    

· If you want to quickly go to a folder, such as the general folder, you can use first letter navigation by pressing “g” until you hear general and choose it by pressing the enter key.

· Braille display readers will likely use first letter navigation or the third thumb key to search for their folder and the enter key or the fourth thumb key to select it.  

Once you’ve selected your folder, you must now choose the file you wish to open.  

document to open press enter for ____ (file name).

As you searched for your folder, you may now use the same technique to search for your file.  You no longer want to look at the Navigation document.  To get a list of documents in a folder, press the third thumb key or the space bar to go through the list until you find the Easy Edit document.  Press the enter key to open the document once you’ve found it. 
The most commonly used command for deleting one character mistake made while writing or editing text is the backspace key (left pinky finger).
This command resembles the backspace key on a computer keyboard and erases the last character you wrote or the character immediate to the left of the cursor.  When using this command you will erase whatever is contained in the previous cell (contractions, single letters, and punctuation or composition signs).  If you want to erase several characters that you just wrote, continue to use the Backspace key to erase the previous character (braille cell).  As you use this command, the Braille Note will say what you have just erased and sound a beep for each erasure.  For example, if you misspelled the word Joan as Jone and then realize you have spelled it incorrectly, as you use the Backspace key to erase the letter e, the Braille Note will say E and sound a single beep.  If you continue to erase using this command, the next time you press the Backspace key, the Braille Note will say n and sound a beep.  At this point, you can correct the misspelled word by brailling the letters a and n.  

By using the cursor routing switches, you can use this backspace key to delete previous cells anywhere in your document.  Make corrections to the easy edit document on the Braille Note using the cursor routing switches to place the cursor one cell to the right of the incorrect letter.  Press the backspace to erase an incorrect letter and then write the correct letter.  When you’ve made your corrections, print or emboss your document.  
Easy Edit Exercise

1. Nina is a guide jog.

2. It cakes five months to train a guide dog.

3. Traveling with a guide dog is nun.

4. Nina takes me around ubstacles.

5. Nina won’t take he across the street if it isn’t safe.

6. Nina and I talk two to four miles a day.

7. I take Nina out to relieve herself give times a day.

8. I crush Nina every evening.

9. It isn’t a good idea to take a guide dog to a roo.

10. You don’t have to line yourself with traffic when crissing the street with a guide dog.

Lesson 8 – PRINTING & EMBOSSING A DOCUMENT

To Print a Document:

When printing, remember that the Braille Note assumes you want to print the last document you were working on and therefore will automatically suggest that folder name and that document name.  

From the main menu – press all six braille keys with space

press W -keyword menu

Press P - print or setup printer? If using this guide outside our class, you may need to set up your printer the first time it is used.  Refer to the manual or read on through this lesson for printer set-up instructions.  

For our class, everything is already setup, press P to print


Folder name, press enter for (your name)
Press enter


Document to print, press enter for ____________ (last document opened)

Press enter


Printer ready?

Line up the infrared port on the Braille Note with the infrared port on the printer.  You may be from a few inches to a few feet from the printer so long as the infrared ports are aligned.
Press Y and the document should print.

Keyword Menu, Printing of (your document name) complete

To Setup the Printer 

If you need to setup the printer or make changes in the setup, make sure you are at the KeyWord menu.  Press p for "Print or Setup printer?" Then Press S 

Printer setup list

Advance through your options with the third thumb key or the space bar.


Paper Length 66



for HP printers, set paper length to 60



for Canon Bubble Jet printers, set paper length to 63

Paper Width 85


Use Form Feeds between pages, currently no


Pause after each page, currently no


Page Offset, press enter for 0


Printer Port, currently infrared

To select the parallel port press P, serial port press S, or the infrared port press I and then press enter.  Press E with space to exit.  

You will be asked to confirm changes?
Press Y for yes and you will be back at the Print or setup printer option.  


Printer Type, currently (printer name), change?

To change the printer type press Y and then press enter.

Printer name?  … 
Use the space bar or third thumb key to cycle through the list until you find the printer name you want to select and then press enter.
Press E with space to exit – confirm changes?

Press Y for yes

That will now take you back to the Print or setup printer option.

Press P Folder name? Press enter for (your folder name)
Press Enter – Document to print, press enter for (last opened document)
Press Enter – Printer Ready? Enter Y for yes or press enter. 
If you respond "no," you may select pages within a document to print without printing the entire document.  

You will be asked start page number? Currently first page 

Input the page number where you want to start, the default is page 1 and press enter.
Finish page number? currently last page

Input the page number where you want to finish, the default is last page and press enter.    

Number of copies? Press enter for 1

Input the number of copies you want to print, the default is 1.  

At the prompt, "printer ready?" press y.  Keyword Menu, printing of ____ complete
To Emboss a Document

The directions for embossing are similar to printing.  From the main menu – all six braille keys with space, press W

keyword menu

Press E

Emboss or setup embosser?
If everything is already setup, press E


Folder name, press enter for (last folder that was open)

Press enter


Document to emboss, press enter for (last document opened)

Press enter


Embosser ready?

Press Y or enter and the document will emboss.

Keyword Menu, Embossing of ____  complete

To Setup the Embosser

If you need to setup the embosser or make changes go to the Keyword Menu and press E for Emboss.  Emboss or Setup Embosser?  Press S for the setup menu.  

Embosser setup list

Advance through your options with the space bar or third thumb key.  The second thumb key or backspace key will move you backward through the options.

Paper Length 25 (to change, type a number and press enter)


Paper Width 40 (type a number and press enter) (for 11 x 11½  use 40 characters per line; for 8½ x 11 use 32.)

Use Form Feeds between pages? currently no (Press Y or N, then press enter)


Pause after each page? currently no


Does your embosser emboss both sides of the page? Currently no (You may change this to "yes" if your embosser supports interpoint embossing.)

Page Offset? press enter for 0


Printer Port? currently parallel


To select the parallel port press P, serial port press S, or the infrared port press I and then press enter.  Press E with space to exit you will be asked to 

confirm changes  

Press Y for yes and you will be back at the 

Emboss or setup embosser option.  

Select the folder and file by pressing Enter when you point at the appropriate folder and then at the file you desire to emboss.  At the prompt, "embosser ready?" Press Enter.
Some embossers require some setup as well.  Instructions for embossing with the Braille Note and the Juliet:

OL  off line
0.1E

11.1E for setting Perf Skip on

17.25 E for page length to 25

30.06 E setting the top of form to 6/10 of an inch

1.1E to set changes and return the embosser "on line"
On the Braille Note:

Page Length – 25

Page Width – 40

Form Feed – No

Pause – No

Emboss both sides – No

Offset – 0

Port – Parallel

Press e with space to save and Y to confirm changes 
Lesson 9 – Advanced Edit

Before beginning this lesson, we will review opening a document.

From the main menu, (all six braille keys with space) – main menu

Press w – key word menu
Press o – folder name, press enter for your last name.  If you want to view the list of folders, press the space bar “list of folders on flash disk” continue pressing the space bar or the first character of the folder name.  Once you find the folder you want, choose it by pressing enter.

Press enter – document to open press enter for ____ (Easy Edit).   You no longer want to look at the previous document.  To get a list of documents in a folder, press the third thumb key or the space bar to go through the list until you find the advanced edit document.  Press the enter key to open the document once you’ve found it. 
Go to the top of your document by pressing dots 1,2,3 with the space bar.

We will now do some more complicated editing, using some of the commands in the next section.  There are several ways to do things.  Students should pick the method that works best for them.  

Deleting or Erasing Using Real Time Editing Commands

Real Time Editing

The Backspace Key can also be used in conjunction with other keys to delete in the following manner:


Current Character - dots 3,6 with the backspace key


Previous character -- dot 3 with the backspace key


Current Word - dots 2,5 with the backspace key


Previous Word - dot 2 with the backspace key

The next 3 options require an affirmative response to complete the deletion. Press Y if you are sure or N to go back to your document. 


Delete to the end of the sentence - dots 1,4 with the backspace key


Delete to the end of the paragraph - dots 2,3,5,6 with the backspace key


Delete to the end of the document - dots 4,5,6 with the backspace key

You can also delete using the deleting commands from the Delete Menu.  To get to the delete menu, press d with space (dots 1,4,5 with the space bar).  You may use the space bar to go through the menu choices.  To select any menu item, press the enter key.  The item at the cursor position will be deleted and you will exit the delete menu and be back in your document. 

Alternatively, after you enter the Delete Menu, you may delete an item at the cursor by pressing the character representing that item.  The item will be deleted and you will exit the delete menu.

The choices are:

Character, press c

Word, enter w for this choice

Previous word, press the space bar until you hear previous word and press enter.

Sentence, press s 

Paragraph, press p

Document, press d

These last three options, delete from the cursor forward.  In order for you to delete the entire document, you must be at the top of your document.  

Inserting

The Braille Note is always in the insert mode, similar to a word processor.  So if you place your cursor where you want to insert something, the text will be inserted before the cursor.  Please note, that to continue writing at the end of your document, you must move your cursor to that location.  

Advanced Edit Exercise

Delete The Extra Words Practice

1. We are is students at CSB.

2. Most of us live lives in the dorm and return returns home every weekend.

3. The classes is are smaller here hear than in local public schools.

4. Some CSB students attend attends Fremont schools for a few class classes per day.

5. Interested students can learn learns to play an instrument or sing sings in the glee club.

Insert Words Practice

1. Our flag’s colors are red, ---- and blue.

2. The United States is made up of ---- states.

3. Alaska, ---- and Texas are our three largest states.

4. Mexico, ---- and Canada are the three countries that make up the North American continent.

5. The ---- is the head of our country.
Lesson 10 – Help

Context Oriented Help

Context oriented help is quite useful in menus or in any application or function, particularly if you don’t go to that option or activity very often.  It provides basic keystrokes or choices for options that are available in any application or function.  To access context oriented help, press H with space (dots 1,2,5 with the space bar).  You will hear the message if the speech is on.  You may need to press the space bar or the third thumb key to hear or read the options available.  If you’d like to read the message with the braille display, use the 3rd thumb key to move forward through the message and the 2nd thumb key to go back through the message.

Built-in User’s Guide

A great feature of the Braille Note is the inclusion of the user’s guide option from the Options Menu.  Having the User’s Guide right under your fingertips is particularly helpful for beginning users.  To go to the User’s Guide Option, press O with space


Options menu

Press U for User’s Guide 

The Braille Note may ask if you wish to Continue reading the last item read in the User’s Guide.  Press N for no, if that’s the case.  Otherwise you will hear


Look up table of contents or index?

To look up a section in the table of contents, press T, to look up a reference in the index, press I.  You may use the space bar or the third thumb key to look through the table of contents or you may find a "key word" in the index was pressing its initial letter.  When you have found the item you wish to read, press the enter key and that section of the manual will be displayed.
Alternatively, you may wish to access the built-in electronic manual with the "quick command", backspace enter and h all at the same time.

Using the Index to Find a "Key Word"

Press I – Braille Note BT Index

Let’s look up some information about wildcards.  Once in the index, type in the letter W to go to choices that begin with the letter W.   Press the 3rd thumb key or the space bar to advance down the list of W items from there.  When you come to Wild Cards Topics, select that option by pressing the 4th thumb key or the enter key.  

Wild Cards Topics Sub Index

File Operations

When Embossing

End of Sub Index

When you hear File Operations, Press Enter.

13.12 Groups of files and Wild Cards

Often you may want to copy a group of related files, such as …

When finished the Braille Note will respond with end of reference

E With space exits the section of the User’s Guide you were in and another E with space will exit the User’s Guide altogether.

Using the Table of Contents to Access the Manual 

For example: To find out how to set up the embosser: 
Go to the Options Menu, press space with O, Options Menu.  

Press U, for User Guide.  Press T for Table of Contents or I for Index  

Table of Contents Braille Note BT Table of Contents
You can use thumb key 3 or the space bar to move forward through the options or the thumb key 2 or the backspace key to move backwards.  Select Embossing and Printing by pressing Thumb Key 4 or the enter key.  Advance through the options again and select Setting Up Embosser or Printer.  To hear the entire passage, press G with space and the Braille Note will read the section.  If you want to read with the braille display, use thumb key three to advance through the section.  When finished the Braille Note will respond with 

end of reference set up embosser or printer

6.2 Setting Up the Embosser or Printer

You can emboss or print from Braille Note’s serial, parallel, or infrared ports… 
When finished Press E with space to exit the section of the User’s Guide you were in and another E with space will exit the User’s Guide altogether.

Lesson 11 - SPELLCHECK

Spell Check

Before beginning this lesson, we will once again review opening a document commands using first letter navigation.

From the main menu, (all six braille keys with space) – main menu

Press w – key word menu
Press o – folder name, press enter for ___________(your name).  If you want to view the list of folders, press the space bar list of folders on flash disk continue pressing the space bar until you find the folder you want and then press enter.  Alternatively, after you are in your folder list, you can quickly go to a folder, such as the general folder, by pressing g to go to the first folder that begins with the letter g.  Once you find the folder you want, select it by pressing enter.

Press enter – document to open press enter for ____ (Advanced Edit).   You no longer want to look at the previous document.  To get a list of documents in a folder, press the third thumb key or the space bar to go through the list until you find the checker document.  Press the enter key to open the document once you’ve found it.  
Go to the top of your document pressing dots 1,2,3 with the space bar.
Using the Spell Checker 

From within your document, press ch sign with space (dots 1,6, with space) to begin the spell check.  I always start from the top of the document because it’s easier to follow along.  We’re going to check the entire document.  Press the space bar or the thumb key 3 to check your options, and then press enter when you are pointing to Document Check.


Document Check. Spel Option?

The options are:


Press I to ignore all occurrences of the word.


Press space with dot 5 to skip only this occurrence of the word.


Press A to add the word to the spelling dictionary.


Press C to correct the word


Press L to look up a word.


Press S for suggestions.


Press space with dots 2 5 to hear the misspelled word.  By pressing these keys a second time, you will hear the contracted braille symbols; and by pressing space with dots 2 5 a third time, you will hear the word spelled out.  

Press C with space to hear the word in the context of the sentence and hear the misspelled word repeated after the sentence.

Press S for 


Suggestion list – go down through the list by pressing the Space Bar or the third thumb key and press enter when you have found the correction you want.  


spec



sped 



spell


Correct all or first?

Press A to correct all.

If there are no suggestions, you will have to find out how to spell the word correctly from another source or try to spell the word a different way.  To enter a correction yourself, at the prompt “misspelled word  option?” press c, braille the correction and then press enter.  You may wish to edit the misspelled word rather than re-write the whole word over.

fil option?

Press S for suggestions list


fail


fib


fei


fig


file Press enter
Correct all or first?

Press A to correct all.

Continue with the spell check until you’ve corrected all of the mistakes the spell checker finds.  When finished running the spell checker, it is important to re-read the document because grammatical errors are not detected by the spell checker.

If a word is spelled correctly but is misused as are the words right, taut, hear and grate in the checker document, then these mistakes must be corrected without using the spell checker.  To do this we will use the find command to quickly find the words that need correcting.  

To find the word right (dot 5 r)

Press f (dots 1,2,4) with space – find.  Search forward or back?
Press F for forward – Find? Write Dot 5 r  and press enter

Right Found to space right comma – the cursor is on the dot 5 of the braille phrase to right; we need to delete the dot 5 r and replace it with the word write.  Do that now.

Now let’s find the word grate.  

Press f with space (dots 1,2,4 and space) – find search forward or back 
Press F for forward – Find? Press enter for right – Now write the word grate and press enter.

Found grate. – the cursor is on the g of grate.  Correct the word to read great. 

Checker Exercise
This is a spel check fil that was created just for you.  It has been tiped using Word and saved to a disk.  It will have some comon mistaks in it as wel as some more compicated ones.  We will lern to use the spell checker as one of the options that you can use to find mistakes.  Sints I don’t know what to right, I think I’ll giv you a breef discription of my backround and how I ended up hear at CSB.  I was rased in the midwest and taut there for six years before I moved to Hawhyee.  Hawhyee was the perfect place for me.  I still consider it my home and I miss it very much.  Cercumstancses braught me to California and now I have the best job I’ve ever had.  Working at CSB is grate.  Now let’s see how many misteaks I made.
Lesson 12 – Using KeyPlan
Planner
The planner is used as an organizing tool.  It may also be used as a daily journal and to keep track of homework assignments.  You can keep track of important dates and appointments that you put in the planner.  You can also set an alarm for any appointment.  

To open the planner, go to the main menu by pressing all six braille keys with space.  

Press P to go to the Key Plan Menu
Press O to open the planner 

Key plan calendar press enter for (the current date) or write in the date you wish.  The date may be written by entering #month, #day, #year and then press Enter.  You may also move forward or back through the calendar by day, week, month or year.  Press h with space for help with this procedure.
Appointments may be entered in two ways, Either press the “en” sign (dots 2, 6) with the space bar  to go directly to scheduling an appointment or press the “st” sign (dots 3,4) with space to go to the appointment menu and then press S to schedule an appointment.  
Appointment date, press enter for  _____ the date of the planner you opened will appear or select any day you wish.
Appointment time?
Enter hours and minutes, followed by a space and a for am and p for pm and then press enter.

Appointment Title

Write the title of your appointment and press enter.

Do you wish to set an alarm on this appointment?

Enter Y for Yes or N for No

If you entered N, you will hear appointment scheduled

If you entered Y, you will be asked to enter the number of minutes before the appointment that you would like the warning alarm to sound.  A number sign is optional and the value can be between 0 and 120 minutes.  

Warning Time – Press enter for _____ minute(s)

 Enter the number of minutes, and press enter.  You will then hear appointment scheduled.

Once the appointment has been scheduled, you will still be on the day in the planner that you have scheduled.

If the power is off when the alarm activates, press:

R to read the details of the appointment

Space to postpone the alarm for 10 minutes

C to cancel the alarm

If the power is on, press the backspace and the enter key to go to the alarm options menu.

Go through the menu

Read the alarm

Postpone the alarm 

Go to the alarm in planner

Cancel the alarm

Press g - canceling and going to the alarm – This option cancels the alarm and goes to the title of the alarm in the planner and reads it.
Lesson 13 – Block Commands 
The Block Commands Menu provides all the commands needed to mark a block of text and manipulate it.  Enter this menu by pressing SPACE with B.  Exit the menu by pressing SPACE with E.  

A "block" is defined as any continuous section of text including one or more characters, words, sentences, paragraphs, or an entire document.  

Copying a block places a copy of the text on the clipboard.

Moving a block of text removes the text from its original position and places it on the clipboard.  These two functions replace the content of the clipboard each time they are used.  Only one block can be marked within a document at a time.

The "append" function adds marked blocks to the clipboard so a list or several passages can be assembled.  

There are 13 items in the Block Commands Menu, in alphabetical order:

· Append block to clipboard

· Copy block to clipboard

· Delete block

· Insert file

· Move block to clipboard

· Paste clipboard

· Read block

· Store block

· Top marker insertion

· Bottom marker insertion

· Erase file and exit Keyword (This is a very powerful command and should not be confused with "delete block" or the "zap" function.)

· Zap, erase the block markers

· Grade - Correct Braille grade of block

Items on the menu can be selected in either of the usual ways. (First letter navigation or arrow keys)

Managing blocks of information is a powerful and essential function for manipulating text.

This editing aid allows one to mark a passage and delete, move, copy or otherwise manipulate it.  A block can be copied or moved between documents or KeySoft tasks.  i.e. Text may be copied between the Browser, Word Processor, Planner, E-mail and Address List.

Marking a Block

Place the cursor on the first character in a document or text passage.  

Press Space with b, block commands menu

Mark the block of text by using one of the following methods:

· Mark the top of the block by pressing t, "top of block".  A marker (dollar sign blt) appears in the document in computer braille to indicate the top of the block.  You will be returned to your cursor position.  Move the cursor past the last character in the passage.  Press space with b to re-enter the block commands menu.  Use the arrow keys or first letter navigation to select the function you wish to perform from the choices on the menu.  If you wish to keep the block marked for future reference, you must insert block markers at both the beginning and end of the block.  A computer braille marker, (dollar sign blb) will be placed at the end of the block.  These markers will be displayed when navigating through the document by character or word. 

OR

· Use "Quick Mark" commands to mark a character, word, sentence or paragraph.  "Quick mark" commands automatically place block markers at the beginning and the end of a passage.  Go to the block commands menu, space with b.  



Mark character under cursor (press SPACE with dots 3-6)



Mark word under cursor (press SPACE with dots 2-5)



Mark sentence under cursor (press SPACE with dots 1-4)



Mark paragraph under cursor (press SPACE with dots 2-3-5-6)

The selection of sentences and paragraphs can be changed to lines and sections by the Reading Mode, as described in the KeySoft version 5 manual, Section 7.6.

The clipboard is an automatic, temporary storage place for the block of text.  If you append, copy or move the marked block to the clipboard, you may then paste (insert) it somewhere else.

Move the cursor to where you want to paste the block in the current document, another document or application.  

Go to the block commands menu, space with b, block commands menu
Press p to paste clipboard pasted
You may wish to execute a different command from the menu instead of pasting the marked block from the clipboard into a document.

Read and Verify the Content of a Marked Block

Press r block read  

The marked passage will be read.  

End of block.  Block commands menu 

You are returned to the block commands menu for further action.

Storing a Block

From block commands menu, press s 

Store block, store block to which drive? Press enter for flash disk
Follow the prompts to select or create the appropriate folder and file.
Deleting a Block

First mark the block of text you wish to delete.  Then enter the Block Commands Menu and select Delete block.  KeySoft displays: 

Delete block, Sure? 

To confirm the deletion, press Y, or, N.  This function completely removes a marked block from your document.  It is useful for deleting large amounts of text.

Additional information about Block Commands and other advanced word-processing functions may be found in Chapter 7 of the KeySoft version 5 Manual.

Lesson 14 – Computer Braille Code

You will need a basic understanding of Computer Braille before using a search engine like Google to explore the Internet.  Computer Braille uses some symbols from Literary Braille, some from Nemeth Code, and some symbols of its own.  Here are the basic symbols you will need for the exercises in this booklet.  Refer to Appendix J.1  United States Computer Braille in the User’s Manual for a complete listing.

Letters are all the same as literary braille letters.  

Numbers are Nemeth numbers with out the numeric indicator.  

The @ sign is a dot 4, on the Braille Note write the @ sign with “U” with the space bar followed by a dot 4.  
The period is similar to a Nemeth decimal point, dots 4,6.

A slash is dots 3,4.

A plus sign is dots 3, 4, 6
Single uppercase characters are preceded by “U” with the space bar for each character.

For a string of uppercase characters you can turn caps lock on by pressing “U” with the space bar twice.  To turn caps lock off type “U” with the space bar once.

To write the following string for a search engine request:

marie curie

marie curie
To write the following string for a search engine request:

benjamin franklin+inventions

Benjamin franklin+inventions

To write the following string for a search engine request:

thomas Jefferson+biography

thomas Jefferson+biography 
To write the following web address:

www.loc.gov/nls/braille
www.loc.gov/nls/braille

To write the following file name for a book:

ramona age eight.brf

Ramona age eight.brf
Lesson 15 – Key Web Browser

The Key Web browser has made Internet access and the ability to do research a relatively simple task for a braille reader using a Braille Note.  This lesson will include an introduction to the Internet using the Key Web Browser.  We will use the Google search engine to do two different searches.  We’ve done these exact searches in the past and they have been chosen for their relative ease and clarity of the web pages involved.  At CSB we generally use the Google search engine for two main reasons.  The first reason is because it’s an uncluttered easy to use web page.  The second reason is because the information in the links is easy for students to read and use for report writing.  

The ability to search the Internet with the Braille Note is amazing.  However, keep in mind, the Internet is still the Internet.  Anyone can design a web page and put it on the World Wide Web, but that doesn’t mean it is well designed or user friendly for users who are blind or have low vision.  Unfortunately, there are still many web sites out there that are graphic oriented and the graphics are not labeled with meaningful text (alt tags).  They may require mouse input to access them.  Links and graphics may simply be labeled “Click Here”, not the best choice of phrases.      

The first search we will do together.  We will be searching for biographical information on Marie Curie to create a report about her life using the Google Search Engine.  Once we find the information we are looking for, we will use the block commands menu to mark the top and bottom of the text we want to copy.  We will then copy the text to the clipboard, create a document and paste the information in the document.

Before we start, it will be helpful to review some basic commands for navigating the Internet.  

Press:

Dots 1,2,3 with the space bar goes to the top of the page

Dots 4,5,6 with the space bar goes to the bottom of the page

G with the space bar will read the entire page 

(press the enter key and the backspace key simultaneously to stop the reading)

The thumb keys are used to read from the Braille display

A link is always between an ow sign and the letter o and can be activated by pressing any cursor routing key above the words in the link

If listening to the web page, a beep sounds just before a link

Pressing the Space bar will go forward through the links

Pressing the backspace key will go backward through the links

Pressing the enter key will go to the link you’re on – “linking, please wait”
Dots 4,6 with the space bar – to go to the first edit field 

Dots 5,6 with the space bar – to move down to a large section of text or to the next paragraph

O with the enter key – to open a web page (computer braille is required)

B with the enter key – move back a web page

F with the enter key – move forward a web page

I with the enter key – says current web page

R with the enter key – refreshes the web page

Lower F with the enter key – opens the favorites menu

Using the Browser

We will start from the Main Menu – all six braille keys with space

Press I – Address, press enter for www.pulsedata.com/keyweb  At the prompt, service to call?  Press Enter - Please wait! 
If using this guide outside our class, please refer to the KeySoft version 5 manual, section 11.9, setup options to setup your Braille Note for Internet access.

Pulse Data Web Browser Page …

The Pulse Data Web Browser Page has several useful links, we will be using the Google link.  

Press the space bar to go through the list of links until you hear Google, then press enter - linking please wait
We will do the first search together and then you will do two searches on your own.  Please stay with me on the first search or you will probably get lost.  The first site on Marie Curie was chosen because it has an option for viewing the text version.

When the Google page has finished loading, press dots 4,6 with space to go to the first input control (edit field) text input.  We refer to this as the Andy box because it has an “and” sign followed by a space for inputting and the letter “y”.  You are now ready to write your search request.  Using the computer braille code, type in the following string:

marie curie and press enter. 

marie curie
Please wait 
Reading is done similarly to reading a document using the word processor.  However, you need to be careful not to press the cursor routing switches while in a link, as that acts like a left mouse click when within the link.  If you accidentally press a cursor routing key within a link, press b with the enter key to go back a page. 

You can also use first letter navigation to browse through the links.  Press M to find links about Marie Curie and stop when you hear Marie Curie and the Science of Radioactivity.  That sounds like a good link.  There are two common ways to activate a link and move to that website page.  One is to press the enter key.  The other is to press a cursor routing switch above any cell within the link.  A link is defined by the symbols “ow” on the left and “o” on the right of the link title in the braille display.  
This site was chosen because it offers a text version.  Press the space bar to scroll through the links until you hear text version.  Activate the link by either pressing a cursor routing key within the link or by pressing the Enter Key.  Read through this page using the thumb keys or by pressing G (dots 1,2,4,5) with the space bar.  After reading through the page, return to the top of the document and press the space bar until you hear the link on Research Breakthroughs (1897-1904).  Activate the link.
Go back to the Google home page and perform a second search on your own.  The second search is to find information about the inventions of Benjamin Franklin.  Press dots 4,6 with space to go to the first input control (edit field) text input.  You are now ready to write your search request.  Using the computer braille code, type in the following string:

benjamin franklin+inventions then press enter. 

Benjamin franklin+inventions

Please wait … Google Search Benjamin Franklin Plus Inventions

We will now use first letter navigation by pressing the letter B until we hear “Ben Franklin and his Inventions” and then press enter.

Linking, please wait … Benjamin Franklin and His Inventions

We should now be on a web page that now has information on Benjamin Franklin and his Inventions.  We can move down the page a paragraph at a time by pressing 5,6 with space or the student can use the thumb keys to navigate through the document while reading the braille.  The information contains 9 paragraphs about Ben.  Read through the information briefly and then return to the beginning of the section describing Ben Franklin and His Inventions.  The information begins with “A list of Benjamin Franklin’s inventions reveals a man of many talents and interests” and ends with “Today’s curious thinkers are keeping Ben’s traditions alive by inventing new and improved ways to make things work”.   We will now mark this text, copy it to the clipboard and paste it in a new document.

Block Commands Menu

Before entering the block commands menu, place the cursor at the very beginning of the text you want to highlight or select.  In this case, on the dot 6 of the capital A of the phrase beginning “A list of Benjamin …”  

Once the cursor is in position, enter the Block Commands menu by pressing 
B With space – Block Commands Menu
Press t – top of block – this places a marker at the top of the block of text you want to highlight and exits out of the Block Commands Menu and puts you back on the web page about Ben.

Now, we want to move the cursor to the end of the block we want to highlight.  You can easily move down a paragraph at a time by pressing Dots 5,6 with space.  Find the phrase that ends “… make things work.”  Place your cursor on the space after the period of that phrase and go back into the Block Commands menu.

B with space Block Commands Menu

Press B - bottom of block, Block Commands Menu 
This places a marker at the bottom of the block of text you want to highlight.  You are still in the block commands menu at this point.  

Press C block copied to clipboard bottom of block

The block of text has been copied and you are now back on the web page.  We have the information we wanted.  At this point we are going switch to the word processor and create a document into which we will paste the information.    

Press the following hot key command to switch over to KeyWord.
W with the backspace and enter keys simultaneously
Folder name, press enter for __________ (your name) 
We will create a new folder on the fly by writing Franklin and pressing the enter key.  

Folder does not exist, create a new folder? Press Y for Yes.
Document to open, ____.  
We will create a new document on the fly by writing Ben Notes and pressing the enter key.  

Document does not exist, create a new document?

Press Y for Yes

Top of Document, Blank

Now, we are going to paste the information on Ben into our document.  

To Paste Information from the Clipboard:

Press B with space Block Commands Menu
Press P to Paste – Clipboard Pasted, two spaces.

The information has now been pasted into your file and you are at the end of your file.  

To go to the top of your document press dots 1,2,3 with space
To listen to the entire document, press G with space (dots 1,2,4,5)
If you want to stop the reading of the document at any time, press the backspace key and the enter key simultaneously.  

Let’s now create a new document for the actual report.  

Press W with the backspace and enter keys

Folder name, press enter for Franklin

Press Enter

Document to open, press enter for Ben Notes
Type in Ben Report and press enter

Report document does not exist, create a new document?

Press Y for Yes

Top of Document, Blank

You may wish to "switch" documents and work between the Ben Notes and Ben Report files.  While one file is open, you may switch to another file by pressing “ou” sign (dots 1,2,5,6) with space.  Do that now.

Document to open, press enter for ____ (previous opened file name appears)

You may press the space to get to the list of documents or backspace to go to the folder and space to get to the list of folders.  When you have selected the appropriate folder and file was pressing enter on your selections, you will then be able to simply use the “ou” sign (dots 1,2,5,6) with space to switch back and forth between the 2 open documents.

Since this is our report document that must be turned in, let’s put our name and the date at the top of the paper and press enter.  Now let’s do a quick block copy of the beginning paragraph and place it in our report document so we can rephrase it in our own words.  To do that switch back to the Ben Notes document.  

Press the “ou” sign (dots 1,2,5,6) with space 

Document to open, press enter for Ben Notes

Press enter

Top of document, two spaces

With 2 keystrokes you’ve switched to the previous document you were working on.  Now, here’s how to quickly mark and copy a paragraph.

Press B with space Block Commands Menu
Press low G with space  - Paragraph marked, Block Commands Menu

Press C – block copied to clipboard 
Now switch back to the report document

Press the “ou” sign (dots 1,2,5,6) with space 

Document to open, press enter for Ben Report

Press enter

(your name) (date)

Press dots 4,5,6 with space to go to the end of your document and go back into the Block Commands Menu.

Press B with space. Block Commands Menu
Press P for Paste – Clipboard Pasted, two spaces.

Now read through the first paragraph and rephrase it in your own words.  Remember not to plagiarize.  When finished, print your report document.  I’ve reprinted the first paragraph below to assist you with your report writing. 

“A list of Benjamin Franklin’s inventions reveals a man of many talents and interests.  It was the scientist in Ben that brought out the inventor.  His natural curiosity about things and the way they work made him try to find ways to make them work better.”
Third Search

We will now do a similar search to find biographical information about Thomas Jefferson.  Use the hotkey command to return to the Internet.  
Press “I” with the backspace and enter keys simultaneously.  You will be returned to the exact web page you were reading when you switched to using the word processor.  Go back to the Google Web page and press dots 4,6 with the space bar to go to the first input control (edit field) “text input”.  Type in thomas jefferson+biography (use computer braille) and press enter. 

thomas Jefferson+biography 
Use first letter navigation by pressing the letter B until you hear “Biography of Thomas Jefferson” and then press enter.

Move down the web page a paragraph at a time by pressing 5,6 with space until you begin to hear biographical sounding information.  The information contains 10 paragraphs about Tom, beginning with “In the thick of party conflict …” and ending with “He died on July 4, 1826.”   

Now, place the cursor at the very beginning of the text you want to highlight.

Go to the Block Commands menu by pressing 

B With space – “Block Commands Menu”
Press t – “top of block” – this places a marker at the top of the block of text you want to highlight and exits you out of the Block Commands Menu and puts you back on the web page about Tom.

Move to the end of the information and place your cursor after the period after the phrase that ends “… July 4, 1826.”  

Go back into the Block Commands menu.

B with space – “Block Commands Menu”

Press b – bottom of block, Block Commands Menu - this places a marker at the bottom of the block of text you want to highlight.  You are still in Block Command Menu.  

Press c – “block copied to clipboard” – 

Now, create a document to paste the information into.    

Press W with the backspace and enter keys

Folder name, press enter for ____ (last folder used)
Write Jefferson and press enter.  
Folder does not exist, create new folder? Press “Y” for Yes
Document to open, press enter for ____ 
Write “Tom Notes” and press enter

Tom Notes does not exist, create a new document?

Press Y for Yes

Top of Document, Blank

Now, we are going to paste the information on Tom into our document.  

To Paste Information from the Clipboard:

Press b with space. Block Commands Menu
Press P for Paste – Clipboard Pasted, two spaces.

The information has now been pasted into your file and you are at the end of your file.  

Before we do anything else, let’s disconnect from the Internet by going to the options menu.  

Press o with space, options menu
Press w, disconnected
Let’s now create a new document for the actual report.  

Press W with the backspace and enter keys

Folder name, press enter for Jefferson

Press Enter

Document to open, press enter for Tom Notes

Type in Tom Report and press enter

Report document does not exist, create a new document?

Press Y for Yes

Top of Document, Blank

This is your report document so write your name and the date at the top of your document.  You may wish to "switch" documents and work between the Tom Notes and Tom Report files.  Switch back to the Tom Notes document now and do a quick block copy of the second paragraph and place it in our report document so we can rephrase it in our own words.    

Press the “ou” sign (dots 1,2,5,6) with space 

Document to open, press enter for Tom Notes

Press enter

Top of document, two spaces

With 2 keystrokes you’ve switched to the previous document you were working on.  Now, here’s how to quickly mark and copy a paragraph.

Locate the beginning of the first paragraph that begins “In the thick of party conflict”
Press B with space Block Commands Menu
Press low G with space  - Paragraph marked, Block Commands Menu

Press C – block copied to clipboard 

Now switch back to the report document

Press the “ou” sign (dots 1,2,5,6) with space 

Document to open, press enter for Tom Report

Press enter

(your name) (date)

Press dots 4,5,6 with space to go to the end of your document and go back into the Block Commands Menu.

Press B with space. Block Commands Menu
Press P for Paste – Clipboard Pasted, two spaces.

Now read through the first paragraph and rephrase it in your own words.  Remember not to plagiarize.  When finished, print your report document.  I’ve reprinted the first paragraph below to assist you with your report writing. 

“In the thick of party conflict in 1800, Thomas Jefferson wrote in a private letter, "I have sworn upon the altar of God eternal hostility against every form of tyranny over the mind of man."  
Do the same for the next several paragraphs and when finished, print your document.  

Lesson 16 – Web Braille  

What is Web Braille?

Web Braille is a web site that contains files for braille books produced by the National Library Service for the Blind and Physically Handicapped.  In order to access Web-Braille books you must have a username and password issued by the agency that represents the Library of Congress in your area.  Once you have a username and password, you can search for books using NLS' online catalog.  To search only Web-Braille titles, you need to enter web braille (as two words) in the keyword field.  Web-Braille book files are in contracted braille ASCII format which has a brf file extension.

The following is a fact sheet from the National Library Service Web Page on web braille.  NLS Factsheets

Web-Braille

Issued July 2003

What is Web-Braille?

Web-Braille is an Internet, web-based service that provides, in an electronic format, many braille books, some music scores, and all braille magazines produced by the National Library Service for the Blind and Physically Handicapped (NLS). The service also includes a growing collection of titles transcribed locally for cooperating network libraries. The Web-Braille site is password-protected, and all files are in an electronic form of contracted braille, requiring the use of special equipment for access.

What does Web-Braille contain? 

Web-Braille contains the full text of thousands of NLS-produced braille books, hundreds of items from the NLS Music Section, and every braille magazine currently produced by NLS. Several cooperating network libraries are now placing books transcribed under their auspices on Web-Braille.

Books. The books currently available through Web-Braille include press-braille books produced by NLS since 1992. More than a thousand older titles are also available. Titles not included are uncontracted, foreign-language, and print/braille books. NLS adds new books to Web-Braille when the hardcopy braille books are approved for shipment. 

Music Scores. About five hundred braille music scores are available through Web-Braille, and more are being added every month. They provide music for a range of instruments, from voice to violin, with levels of difficulty from beginning methods to advanced works, especially for the piano. The styles of music span a range from popular songs to the standard repertoires for each instrument, with particular focus on the eighteenth-, nineteenth-, and early-twentieth-century masters.

Magazines. Beginning May 2001, all NLS-produced braille magazines became available on Web-Braille. Magazine files are normally available on the Web-Braille site within one working day from the time the hardcopy magazine is shipped to readers. Issues of a few magazines are available back to early 2000, and every issue of the music publication Popular Music Lead Sheets can be accessed beginning with the first issue in 1978.

Who is eligible to use Web-Braille?

Copyright laws require that access to Web-Braille be limited to NLS patrons and eligible institutions. Access outside the United States, except to eligible American citizens, is not permitted.

Eligible institutions include:

1. Schools for the blind; 

2. Public or private schools providing braille to blind children, whether the school is set up as a special-format deposit collection or as an institutional patron; and 

3. Nonprofit organizations whose primary purpose is to produce braille books for the use of eligible readers in the U.S. Some examples are instructional materials resource centers and nonprofit transcribing agencies. 

Agencies may use Web-Braille files only to produce braille copies. Under current copyright law, agencies may not make large-print or unencrypted e-text versions of books without the permission of the copyright holder.

How do eligible individuals or institutions sign up for Web-Braille service?

To register for Web-Braille, eligible program users must first contact their cooperating network library and provide the library with an e-mail address and a six-to-eight-character password. When the subscription is activated, the new subscriber will receive access instructions by e-mail.

How can a specific Web-Braille book be located?

Web-Braille books may be located in two ways:

1. Online Catalog. Links to Web-Braille books are included in the NLS online catalog. This catalog is located at www.loc.gov/nls/textcatalog. To retrieve Web-Braille titles using the quick search page, put the words "web braille" (as two words with no hyphen) in the "keyword" field. The results list will contain a link to each volume of a Web-Braille title. When a Web-Braille volume is selected, the user will be prompted for a Web-Braille user ID and password. 

2. Braille Book Review. The Web version of each issue of Braille Book Review published since July-August 1999 contains links to all new braille books available on Web-Braille. The online version of Braille Book Review can be accessed from the main Web-Braille page or from www.loc.gov/nls/bbr. 

In what format are the Web-Braille files? 

Web-Braille files are in contracted braille ASCII format. Each file represents one volume of a braille book or magazine. Each volume of an NLS-produced book is named with the book's BR number and volume number and has a ".brf" file extension. For example, volume 2 of BR 12345 will have the filename "12345v02.brf". Items from the NLS Music Section are named with their BRM number but have the letter "m" preceding their volume number to distinguish them from national collection braille titles. Items produced for cooperating network libraries have a two-letter state abbreviation followed by a three-digit book number. Magazine files have a two-letter magazine code, followed by the month, day (if applicable), year, and letter indicating part. All files on Web-Braille have a .brf file extension.

What equipment is needed to access Web-Braille?

Web-Braille files may be read online or downloaded for viewing offline or embossing with a braille display, braille-aware notetaker, or braille embosser.

Is technical support available for Web-Braille?

Web-Braille technical support is provided through a series of "frequently asked questions." These FAQs are accessible from the main Web-Braille page.

California (Southern California)

Regional Library

Braille Institute 
Library Services 
741 North Vermont Avenue 
Los Angeles, CA 90029-3594 

Librarian: Dr. Henry C. Chang 
Telephone: (323) 663-1111, ext. 500, and (323) 660-3880 
In-WATS: 800-808-2555 
TDD: (323) 660-3880 
Fax: (323) 663-0867 
E-mail: bils@braillelibrary.org 
Web site: http://www.braillelibrary.org/ 

Top
California (Northern California)

Regional Library

Braille and Talking Book Library 
California State Library 
P.O. Box 942837 
Sacramento, CA 94237-0001 

Librarian: Ms. Donine Hedrick 
Telephone: (916) 654-0640 
In-WATS: 800-952-5666 
Fax: (916) 654-1119 
E-mail: btbl@library.ca.gov 
Web site: http://www.library.ca.gov/html/pubser05.html 

Subregional Libraries

Talking Book Library for the Blind 
Fresno County Public Library 
Ted Wills Community Center 
770 North San Pablo 
Fresno, CA 93728-3640 

Librarian: Ms. Wendy Eisenberg 
Telephone: (559) 488-3217 
In-WATS: 800-742-1011 
TDD: (559) 488-1642 
Fax: (559) 488-1971 
E-mail: wendy.eisenberg@fresnolibrary.org 

Library for the Blind and Print Disabled 
San Francisco Public Library 
Civic Center 
100 Larkin Street 
San Francisco, CA 94102 

Librarian: Mr. Martin Magid 
Telephone: (415) 557-4253 
Fax: (415) 557-4375 
E-mail: lbphmgr@sfpl.lib.ca.us 

Accessing the Web Braille site using the Braille Note

Please Note:  There are two requirements needed before you can download web braille books with your Braille Note.  The first is Internet Access.  If you are using this guide outside our class, please refer to the KeySoft version 5 manual, section 11.9 to setup your Braille Note for Internet access.
The second requirement is a user name and password assigned from your local Talking Book library.   
We will start from the Main Menu – all six braille keys with space

Press I – Address, press enter for www.pulsedata.com/keyweb  
At the prompt, service to call?  Press Enter - Please wait! 

PulseData Braille Note Web Browser Page

We have opened the web braille page many times and unless we follow these steps exactly, we have not been successful.  Please follow these steps precisely.  

To open the Web Braille page
Press “O” with the enter key 
Address, press enter for pulsedata.com/keyweb/ 

Type in the following address in computer braille:

www.loc.gov/nls/braille and press enter
www.loc.gov/nls/braille

Please wait, enter network password dialog

At this point it is critical to use the third thumb key to advance the braille display.  Advance forward until you see the cursor after the words “user name?” and enter your user name in computer braille.  Then use the third thumb key again to advance the braille display forward until you see the cursor after the word “password?” and enter your password in computer braille.  

Now press the third thumb key and you will hear Save this password in your password list? Unchecked  Press the enter key to change it to “checked”  
Save this password in your password list? Checked  

Then press the third thumb key until you hear OK Button and press enter.
Web Braille
Congratulations! You can now search the catalog and find a book to download.

Note: If you are running version 5, once you’ve saved your user name and password, it will go directly to the Web Braille site until you have to reset your Braille Note.

Once on the site, find the on-line catalog link by either pressing the space bar to go through each link or press the letter “O” to go to the first “O” link online catalog.  Activate the link by pressing enter or any switch above the link.
Please wait
You will probably hear some beeping sounds, this is normal.  It’s a signal that the Braille Note is busy loading the Web Page.  
NLS Quick Search of the On-line Catalog

Press dots 4, 6 with space to go to the first input control (edit field).  We refer to this as the Andy box because it has an “and” sign followed by a space for inputting and the letter “y”.  
Author last name first, text input
At this prompt, you should input the author’s last name followed by their first name.
We will practice the first one together as a group.  Let’s use Beverly Cleary.  Using computer braille, write her last name followed by a space and then her first name.  

Do Not Press Enter 
Press dots 4,6 with space to go to the next input control (edit field) Title, text input. 

If you were searching for a specific title, you would enter that information here.  We are not going to search for a specific title.  We are going to skip this and see how many books are available in web braille format by this author.  

Do Not Press Enter 

Press dots 4,6 with space to go to the next input control (edit field) Keyword, text input.
In order to limit the search to only those books that are available in web braille format, we need to write the words web braille in computer braille here.

Web braille
Now, you can press enter.  

If you spell the name incorrectly, No records will match your query.  
Click, please wait Voyager and Cleary Beverly …

Now let’s read this web page.  We will read one paragraph at a time by pressing dots 5, 6 with the space bar to advance to the next paragraph.  
Record 1 through 14 of 14 returned.
This means there are 14 books by Beverly Cleary.  
Note: Some of these books have multiple volumes that must be downloaded separately.
Press dots 5, 6 with the space bar to advance to the next paragraph which includes information about the first book in the list:

Author:
Cleary, Beverly.

Title:      Beezus and Ramona [braille] / Beverly Cleary.

Published: [Washington, D.C.] : NLS, 1992.  (Braille

                  International, Inc., transcribing agency. Braille

                  International, Inc., distributor)

Book Number:   BR 08744

Access: Volume 1.

    Location:  http://www.loc.gov/nls/braille/08744v01.brf
More on this record
At this point you could continue pressing dots 5,6 with the space bar to advance through each of the 14 books in the list.  To go back through the list a paragraph at a time press dots 2,3 with the space bar.  

We will stop when we hear:

Author:
Cleary, Beverly.

Title:      Ramona Quimby, age 8 [braille] / Beverly Cleary.

Published:     [Washington, D.C.] : NLS, 1998.  (APH,

                  transcribing agency. APH, distributor)

Book Number:   BR 11491

Access:        Volume 1.

    Location:  http://www.loc.gov/nls/braille/11491v01.brf
More on this record
Now we need to activate the link to get ready to download and save this book on our Braille Note.  We heard that there is one volume.  Press the space bar and you will hear:
http://www.loc.gov/nls/braille/11491v01.brf 
Press the enter key or one of the switches above the link to activate the link.  

Linking, please wait
Once you begin to hear the web site page http://www.loc.gov/nls/braille/11491v01.brf count slowly to 20 to make sure the entire page loads completely.  If you rush it here, the Braille Note will likely crash and you will need to start over.  

Press S with the space bar to save this volume.  

Folder name? Press enter for General

At this point you must decide where you want to save the book.  If students do not have a separate compact flash memory card, they will have to save on the flash disk.  If they have a memory card, that will be the best place to save books.  

Let’s assume you have a memory card inserted in the storage card slot on the right side.  You are currently at the folder level on the flash disk and must press the backspace key to go back to the disk level.  Once there you can go through your choices by pressing the space bar or third thumb key to go through the list.  When you hear 

Storage Card, press enter.  
Folder name, press enter for none
We suggest that students organize their books using the authors’ last name as the folder name.  Write Cleary and press enter.
Cleary folder doesn’t exist, create a new folder? 
Press Y for yes

File name? Computer braille is required.
Write ramona age eight.brf  
Ramona age eight.brf

You must use the brf extension or the book will not open correctly.  
Saved
Remember if there are multiple volumes in a book you must go back a page by pressing “B” with the enter key and hit the space bar once to go the next volume link http://www.loc.gov/nls/braille... 

Lesson 17 – Downloading Bookshare Books with KeySoft Version 5 and Up
Bookshare.org is an excellent source for electronic books.  It requires a annual individual or institutional subscription.  Contact www.bookshare.org for more information.

Logging In to Bookshare

Start from the Main Menu – press all six braille keys with space

Press I – Address, press enter for www.pulsedata.com or “your own home page”

Or braille the following in computer braille www.bookshare.org and press enter.

At the prompt, service to call?,  choose your own service and press enter.  

If your own service is not offered, review the choices by pressing the space bar until you find the service you want and then press enter.  

Please wait (it may take several seconds to load this page)

When you find Bookshare.org either press L to go to the log-in link or, press the space to review all of the links to familiarize yourself with the options on this page.  

Activate a link either by pressing enter when you are pointing to the link or press a cursor routing switch within the link.  

Please wait, security alert dialog.

You may read the alert and when you get to the OK button, press enter.  

When the message bookshare.org, log into bookshare.org. appears, you are ready for the next step.

Press space with 4, 6 three times or until you find e-mail text input.

Enter your user e-mail address in computer braille.

Press space with 4, 6 to go to the next input field and enter your User Password in computer braille. 

Press space with 4, 6 until you find submit button and press enter.

Bookshare.org, log into bookshare (this message may appear again after pressing the submit button)

Searching for a Title
Once you have correctly logged into Bookshare, press space with 4, 6 to go to the first input field “Search Selection List Title”.  Write the title in computer braille.  If you wish to search by author instead, press the space bar until you find author and then press enter.  “Search Selection List Author”
Press space with 4, 6 to get to the input field.  Use computer braille to write the author’s name.  Press enter when finished.

Click! 
You may come to the Internet Redirection Dialog Box
Read through until you find the Yes button and press enter.  
Bookshare.org Books by Author

From the top of this page (press SPACE with 1, 2, 3)

Press enter with 5, 6 and you should find

Books by Author, Author’s Name
Select one of the author’s below for a list of books by that author.  

Press the space bar to go to the link of the author’s name and activate the link by pressing enter or a cursor routing switch within the link.  

Linking, please wait!

Bookshare.org, books by author

Press enter with 5, 6, to get to books by, “author’s name”.

OR Press space bar to go the list of books by that author.

Activate the link by pressing enter or a cursor routing switch within the link.  

Please wait, linking.

Bookshare.org, book information

Go to the top of the page by pressing space with 1, 2, 3

Press B twice and you should find “brf braille digital format”

Activate the link by pressing enter or a cursor routing switch within the link.  

Linking, Please wait!

Download file into which folder?

If you want to choose a different drive or do not know which drive you’re in, press the backspace and go through the list and make your selection.

Download file into which folder? 

If you’re on the flash disk, press the space bar until you find downloads and press enter.  

Select your choice or press enter for what is recommended.  This is a zipped file which must be unpacked in the Braille Note.  

Download a file, “bookname”.bks complete.  The book is now a zipped file on your flash disk in your downloads folder.  

Using the Unpack Utility

You must open the Book Reader to start the unpack utility.  

Go to the Main Menu and press B 

Read book in which folder? Press enter for downloads 

or locate your book wherever it was stored and press enter 

Book name, press enter for “bookname”.bks

Press enter

Folder for unpacked bookshare book?

First you must choose what drive you want to save your book in.  You are at the Flash disk and can either create a new folder on the flash disk or use an existing folder.  

If you want to choose a different drive, press the backspace.  Go through the drive list and make your selection.

Once you’ve chosen your drive. You have 3 choices:

Option 1.  Write the name of an existing folder and press enter.

Option 2.  Create a new folder by writing the name and pressing enter. When prompted “Folder does not exist, create a new folder?” Press Y for Yes.

Option 3. Select from the list of existing folders by pressing space and then enter when you find the desired folder.  

Password, computer braille is required. 

Enter your bookshare password in computer braille and press enter. 

Delete the original packed bookshare book? 

Press Y for Yes if you’re confident or press N for No is you feel you need a backup just in case.  

Unpacked book is called “bookname”.brf 
Press enter to open the book.  If asked to Review the Options?, press N for No.

Read your book. Enjoy it.

Lesson 18 – Copying Files 

We will now copy some files for you to work on.  We have placed files in a folder on the flash disk called Braille Note Training.  The first thing you will do is create your own folder and copy the training files in to it. 

From the main menu, (all six braille keys with space) – main menu

Press F to go to the file manager 
Press F again to go to the folder manager menu

Press C to create a folder Create folder on which drive?  Press enter for flash disk.

Press enter New folder name?
Write your first and last name and press the enter key.  

Folder created. Folder manager menu
Press the backspace key to return to the file manager menu
Now press c to copy files.  

Source drive? Press enter for Flash Disk 

Press F for flash disk.  

Source Folder name?  Press the space bar or the third thumb key until you hear Braille Note Training.  

Press enter  Source file name

Press space with dots 3,5 (“in” sign) Multiple character wildcard.  This will select all of the files in the "source" folder.  Press the enter key.  
Destination Folder name?   Press Enter for ____ (your name)
# files were selected, confirm each file? Write N for no.
# files copied, file manager menu
Now you have successfully copied files from the Braille Note training folder into your own folder.  We will now begin working with those files.  
If you are working in Version 5, we must unprotect the copied files.  To do this, at the "file manager menu" press p 

Protect file on which drive? Press F for flash disk

Folder Name? Press enter for ____ Press the space bar to get a list of folders

Input the first letter of your name until you hear your folder name.  Then press enter.

File Name? Press space with dots 3,5 (“in” sign) Multiple character wildcard.  Press the enter key.

# files were selected, confirm each file? Write N for no.
Protect or Unprotect the files? Press U to unprotect.

# files unprotected – File Manager Menu

Return to the Main Menu by pressing all six keys with the space bar.

Lesson 19 - Copying Files from Memory Cards & Creating Folders on the Fly
For the purposes of this lesson, you will be provided with a compact flash card and a PC card adapter.  We will put the two together and slide the card into the Storage Card slot on the right hand side of the Braille Note.  Do not force the card into the slot.  It should slide in easily until near the end, then press firmly to connect the card.  You should hear Card Inserted.

We will start from the main menu.  Press all six braille keys with space - main menu
Press F 

File manager menu

Press C

Source drive, press enter for flash disk
Press the space bar or third thumb key to view a list of drives.  If you have a compact flash card in the slot on the back of the Braille Note and a card in the storage slot on the right side as well you will have 4 choices in your list, Compact Flash, Flash Disk, KeySoft System Disk, and Storage Card.  If either the Compact Flash Slot or the Storage Card slot does not have a memory card in it, you will not find it as a choice in the list.  
Press S for Storage Card 

Source folder name? Press enter for ____ (none or the last folder used)

Press the space bar or the third thumb key and a list of folders will appear.  Go through the list and select the folder you want and press the enter key.      

Once you’ve selected your folder, you must now choose the file you wish to copy.
Source File Name? 

Press the third thumb key or space bar to get to the list of all files and go down the list until you find the file you want.

Press thumb key 4 or the enter key to select the file.

Destination Drive, Press enter for Flash Disk – Press F for Flash Disk

Destination Folder Name, Press enter for ____
Press thumb key 3 or the space bar to get to the list of all folders on the Flash Disk or to create a folder on the fly, simply braille a new folder name and answer yes when asked if you want to create a new folder. 
One file copied, file manager menu
For organization purposes, saving all documents in the General folder can be confusing. Good folder organization skills are essential for efficient use of the Braille Note.  We suggest that students organize their documents in specific folders rather than general folders.  For example, instead of creating a general folder titled English, it may be more efficient to have a Vocabulary Folder, a Grammar folder, a writing folder and so on.  

Copying multiple files

Press all six braille keys with space - main menu
Press F 

File manager menu

Press C

Source drive, press enter for flash disk. Press S to go to Storage Card.

Source folder name? Press enter for _____

Press the third thumb key or the space bar to get to the list of folders on the Storage Card.  

Press B to go to the Braille Note Training Folder

Source File Name?

Press in sign (dots 3,5) with space

Multiple Character Wildcard press enter

Destination Drive?

Press F – 

Flash Disk, Destination folder name press enter for ____. 
Write Copying Practice and press enter.  

Folder does not exist, create a new folder?  

Press Y for Yes

# of files selected – confirm each file?

If you select N for not confirming, all files in the folder will be copied.  If you select Y for yes you will have to confirm each individual file. 

OK to copy ______. You will hear each file name in alphabetic order to which you respond Y for Yes or N for No.  

# Files copied, file manager menu

Lesson 20 – Using Windows Explorer with a PC for File Management
Prior to copying media files over to a Braille Note it will be necessary to have a good foundation of using the computer with Jaws, Real Player 10 and Windows Explorer.
Setting up Windows Explorer 

Windows Explorer is the file management program in Windows. This program is used to find, copy, and move files. It is fairly easy to navigate and use, once you choose the correct settings. 

Hold down the Window Key and lightly tap the letter E to open Windows Explorer.

Note: If you press down the letter E key hard or hold it for an extended period of time you will open multiple copies of Windows Explorer, please use a light tap when pressing the letter E.

In the View menu select “Details” to list all items as a single column list (Alt+V and then D).

In Windows XP you will need to go to the Folder Options in the Tools Menu (Alt+T and then O).  In the General Folder tab:

· under Tasks, Select “Use Windows classic folders”

· under Browse folders select “Open each folder in the same window”

· under Click Items as Follows select “Double-click to open an item”.

To get to the View Folder tab in Folder Options, hold down the control key and press tab once.  Tab twice to get to the Files and Folders Items and press the down arrow until you find Hide extensions for known file types – ON/Off. Turn it off to allow you to view the file extensions.  (Press the space bar to toggle between the On/Off options).  Now hold the shift and press tab twice and activate the “Apply to all folders button” by pressing the space bar.  Now all the folders will display in the same window with a single list of folders and files.  You can begin working in Windows Explorer. 

In Windows Explorer, there are generally 4 options:
· The Tree View (on the left) 
· The Folder View/List View (on the right)
· The Address Bar (below the menu bar and icons)
· The Close Button on the Folder Tool Bar (directly above the tree view)
Windows Explorer opens on the left side of the screen in Tree View.  The Tree View lists the various drives on the computer and places you would likely want to explore like My Documents.  Use first letter navigation by pressing the letter M until you get to My Documents or find My Documents by navigating with the arrow keys.

To create a new folder in My Documents, follow these steps:

· Press Alt to get to the menu bar

· Press F to open the File Menu
· Press W to open the New sub menu
· Press F to create a new folder

A new folder edit box appears on the right side of the screen in the Folder View/List View and you can now type the name of the new folder and press enter.    

The Tree View, on the left side, has different levels of drives and folders.  


Level Zero is the desktop



Level 1 has folders such as:




My Documents




My Computer 




My Network Places




Recycle Bin




Other Folders on the Desktop



Level 2 has common folders in My Documents such as:




My Music




My Pictures




My Videos



Level 2 has common drives such as:





3 ½ Floppy (A:)





Local Disk (C:)





CD Drive (D:)





CD Drive (E:)





Removable Disk (F:)

Every computer is slightly different depending on the specifications and when it was purchased.  You can only view folders and drives from the Tree View side on the left.  When viewing things on the Tree View side as soon as you move the focus to a folder or drive, the computer attempts to access and open it.  This generally works fine.  It will not work if for example, there is no disk in the 3 ½ in Floppy A drive.  Then, an insert disk dialog box comes up and you must cancel it to go any further.  Drives and folders can be opened using the right arrow and closed using the left arrow.  Once you open a folder like My Documents, there can be many subfolders and files within it.  

If you want to look at everything in a folder, tab once to go over to the Folder View/List View Side of the Screen.  It is safer to view things in the Folder View/List View because the computer will not open any drive or folder until you press enter.  

On the Folder View/List View side (the right side), you can find a specific file or folder by using first letter navigation.  Continuously press the first letter of a folder or file you want to open.  Once you find it, you can press enter to open it.  Another way to navigate is to use the arrow keys to move up and down through the list one file or folder at a time.  These methods of navigating work in menus as well.

Deleting Files

Once you are pointing at a file you want to delete, simply press the delete key.  You will see a Confirm File Delete dialog box asking if you are sure you want to delete that file.  If you’re certain, you can choose the “Yes” button by pressing the space bar or enter.

Moving a File

To cut a file and move it to another folder, follow these steps:

· Navigate to the file.
· Go to the edit menu and choose cut (Alt+E and then T).
· Navigate to and open the folder you want to move the file to and paste it by:



Holding the control key +V or



going back to the edit menu and choosing paste  (Alt+E and then P)

Press the backspace key once to go back to My Documents and start the process all over again if you have other files you want to move.
Copying a File

To copy a file and paste it to another folder, follow these steps:

· Navigate to the file.
· Go to the edit menu and choose copy (Alt+E and then C).
· Navigate to and open the folder you want to move the file to and paste it by:



Holding the control key +V or



Going back to the edit menu and choosing paste (Alt+E and then P)

Press the backspace key once to go back to My Documents and start the process all over again if you have other files you want to copy.

Lesson 21 – Media Player

Before you can use the Media Player in the Braille Note, you must have some music files saved in MP3 format with a bitrate of 64 kbps if you’re using KeySoft Version 5.  The newly released KeySoft Version 6.0 accepts a bitrate of 128 kbps.  The recording quality is better when using a higher bitrate.  The latest version of Windows Media Player does not offer an option to save in a format that is lower than 128 kbps so if you do not have KeySoft Version 6.0 then use Real Player 10.  Check the CD under Free Downloads for the free version of Real Player 10 and Install it on your computer.    

To set up your Real Player to save files in MP3 format for your Braille Note, you will need to do the following:

If you are using Jaws, start that first, then start Real Player.

Go to Preferences in the Tools Menu (Alt+T and then P)
The Preferences dialog box has a tree view on the left hand side of the dialog box and displays the options on the right hand side of the box.

General is the first category in the tree view that is open.  Tab 3 times to get to the My Library Files Edit box and type the location that you want your music saved to.  
For Example: C:\Joan’s Music\ 

Then press shift+tab 3 times to go back to the General category.

Now, use first letter navigation to go to the CD category. (press C until you hear CD)
There are several things you want to make certain are checked and set under this CD category.

First, you want the CD to automatically start playing and you always want to be prompted to save the CD when it’s inserted.

To do this, Tab once and you will hear:

When inserting a CD, start playback check box (checked or unchecked).  The space bar will toggle through the options of check or uncheck.  You want to make certain it’s checked.  

Press tab to go to the next option

Prompt to save CD, check box (checked or unchecked).  The space bar will toggle through the options of check or uncheck.  You want to make certain it’s checked.  

Press Tab to go to the Select a format list box.  The up and down arrow keys will move through your choices here.  Choose mp3 format.

Press Tab to go to the Select a Quality Level list box.  The up and down arrow keys will move through your choices here.  Choose 64 kbps stereo (this level of format or lower will work with the Media Player on the Braille Note)

Tab to the OK button and press space bar to activate.

Now pop in a CD you want to convert to MP3 format Select the Play or Save Music from Audio CD using Real Player Option.  Respond with Yes when prompted if you want to save the tracks.  If that doesn’t work go to the CD submenu under Tools and select Save CD Tracks from your CD location.  You might get a Dialog Box asking if you would like to stop playing the CD and Save the files, you should respond with Yes.  Then a Save Tracks Dialog Box will appear.  Choose Select All with an Alt+S command and then press enter.  The songs should begin to save, the process takes a while but the CD should pop out when finished.  Good Luck!
Copying Files to a Card Reader 

Once you’ve ripped some of your favorite songs onto your computer, you will need a compact flash card reader installed on your PC to copy your MP3 files onto a compact flash card.  When purchasing a card reader, make certain it will read a compact flash card.  Information on ordering can be found in the Compact Flash Card Reader Info Section of this booklet, see the Table of Contents for the exact page number.  
Start Jaws and open Windows Explorer and then open Windows Explorer again.  It will be easier to have two copies of Windows Explorer running to copy songs onto your compact flash card. 
To copy a file and paste it to another folder on your Compact Flash Card, follow these steps:

· Navigate to the file.
· Go to the edit menu and choose copy (Alt+E and then C).
· Hold down Alt and do not let go.  Lightly press tab until you hear My Computer.  This is called fast switching and you will immediately make active the other Windows Explorer Program that’s running.  
· The Compact Flash is listed under My Computer as a Removable Disk, press R to take you to Removable Disk ____ (F:) (it can be listed as E:, F:, G: …)
· Create a new folder with the Artists’ last name.  Alt+F and then W followed by F and type the artists’ name and press enter twice.  Braille Notes will read files from only one folder deep.  Please remember that when copying your music files.  If you have a big folder called music and then subfolders with the artist’s name and another subfolder with the album name, you will have difficulty finding your files with the Braille Note.  It is easiest to place songs directly in a folder with the artist’s name.   

· Paste the file into the folder by:



Holding the control key +V or



Going back to the edit menu and choosing paste (Alt+E and then P)

Once you’ve pasted one song, you can Alt+Tab to go back to your Music folders, follow the steps above and copy as many other songs as you have room for on your compact flash card.  A typical song takes up an average of 1500 – 2000 KB of space.  On a 32 MB card you might be able to fit 20 songs.  
When you are finished, you MUST safely remove your compact flash card to make certain no file gets corrupted.  Close all programs except Jaws by using the Universal Exit Command (alt+F4).  Minimize Jaws and return the focus to the desktop (Window+M).  Use the Jaws hot key command Insert+F11 or Press Tab until you get to the System Tray.  Then use the right arrow until you find the Safely Remove Hardware button.  Activate the button by pressing the space bar.  Choose your device and press enter.  The Safe to Remove Hardware Dialog Box will appear with the following statement:
“The ____ device can now safely be removed from the system.”
Take the card out and put it in your Braille Note.  Your compact flash card will hold many songs.  Rather than copying songs directly onto your Braille Note Flash Disk, play them directly from the Storage Card slot or the Compact Flash slot.  
Playing Songs with the Media Player

Press all six braille keys with space - main menu
Press M – 

Play Media file in which folder? Press enter for ____  
Locate the drive (press backspace to get to the drive list) and folder and file you want to play and press enter.  The song will start to play after it loads, be patient (5-10 seconds).  

You can stop a song at any time by pressing backspace and enter simultaneously.  Restart it by repeating the last command.  A 4 dot braille cursor (progress bar) indicates where you are in the track.  You can press a cursor routing switch to moveforward and backward through the track.  
Press all six braille keys with space to stop the Media Player altogether and exit to the main menu or press space with E to exit a song and select another.  

Media file to play, press enter for ____ (your last song played)

You can navigate down with the space bar to find another song in the same folder or press backspace to choose a different folder and song.  
Lesson 22 – Ink Print Formatting
Braille and print documents may be embossed or printed directly from the Braille Note with no changes to either document format.  Changes in a braille document may be made for print output without affecting the braille format, so when a document is printed, it conforms to a desired presentation style or format without changing that of the braille document.

Most often, a student is asked to turn-in printed documents with name, class, and date in the upper left or right corner of the first page.  Additionally, they are requested to:  center titles, indent paragraphs, use page numbers in some specific location on the page, and occasionally, use double line spacing.  Students may also be requested to apply attributes such as underlining, bold or italic print.  
These attributes may be applied if the printer being used is supported by KeySoft.  
Refer to the KeySoft Version 5 Manual section 6.9, "printer setup list," or consult the manufacturer or distributor for details.  
These commands must be turned on before the text where you want the attributes and then turned off after the text where you want the attributes.  

Here is a list of the most used font attributes:

Bold On - Press F with the enter key followed by B then followed by N 

Bold Off - Press F with the enter key followed by B then followed by F

Italics On - Press F with the enter key followed by I then followed by N 

Italics Off - Press F with the enter key followed by I then followed by F

Underline On - Press F with the enter key followed by U then followed by N 

Underline Off - Press F with the enter key followed by U then followed by F

If the printer being used is not supported, a work-around is to write characters in quotes to indicate the beginning and ending of the attribute.  (Painful but doable) You may use the following code: 
“bb”  bold begin

“be”  bold end 

“ib”   italics begin

“ie”   italics end 

“ub” underline begin

“ue”  underline end 

The steps below may be used to accomplish simple formatting tasks.  Details for these and more complex formatting requirements may be found in Chapter 7.4 of the KeySoft Version 5 Manual.

All ink-print formatting changes must be initiated from within a specific document at the point from which you want them to occur.  Formatting that affects the entire document must be initiated at the top of the document.  Format commands are activated from the point in a document where you initiate each command and will be terminated with either another formatting command or 2 new lines (pressing the enter key twice.)

Create or open a document.

Write your name ____ then press the enter key.

Write the class name ____ then press enter

Write the date ____ then press enter

The name, class and date will be placed on separate lines at the top left-hand side of the page in both the brailled and printed documents.

To center a line in braille and print, such as the title of a report, press enter with c  
Center Line

Write the title and press enter
The line will be embossed or printed in the center of the page.

In the print document if you wish to indent the beginning of paragraphs, or make other changes, you must change some of the settings in the "ink-print format menu."  The format menu has settings for both braille and ink-print.

The menu items are:

layout (braille only)

center a line (braille and print)

right justify a line (braille only)

style of presentation (braille and print)

ink-print settings (print only)

page settings (braille only)

templates (braille only)

end of menu

To go to the format menu, press dots 2,3,4,6 (“the” sign) with the space bar

format menu
Press “I” or cycle through the menu with the space bar or third thumb key to "ink-print settings" then press enter.  
Ink-print settings menu
The Ink-print settings menu items are:

layout

inclusion

start ink-print exclusion

end ink-print exclusion

translation options

page settings

end of menu

Press “L” for ink-print layout list and press the space bar or third thumb key to cycle through the list.  If you change the value of any setting, the word "changed" will appear in parentheses after that item.  If you do not change the setting of an item, the word "unchanged" will appear.

indent first line of paragraph? 0 unchanged.  To indent 5 spaces, enter the number 5, or whatever value you choose, and press enter.

Indent rest of paragraph? 0 unchanged.  You may enter a number if you want the rest of the paragraph to also be indented.  You may choose to indent the first line 10 spaces and the rest of the paragraph 5 spaces thus setting it off from the rest of the body of the text as a hanging paragraph or a response to a question.

Continue to cycle through the list of menu items by pressing the space bar or the third thumb key.

tab stops  To change the value of any tab, press enter.  tab 1: indent 5, unchanged. 
You may change the value of that tab by writing in a number.  The factory default is indent in increments of 5 spaces for each tab through tab 10.  Continue to press the enter space or third thumb key to move through the tab stops, changing values wherever you wish.  After you complete the changes in the tab stops, press space with e to exit tab stops and continue through the menu.

If requested to put student identification information on the top right side of the page, press tab 7 times to move to column 35, write the information and press enter.  Do the same thing for each line to be placed in a column at that position.  Alternatively, set the value for tab 3 to the number 25.  This will place any information at column 35 to the right of center if the standard 10 space left and right margins are not changed.  Press space with e to exit "tab stops."

Press the space bar or third thumb key to continue through the list.

line spacing? single unchanged.  

For single line spacing, press “S”.  

For double line spacing, press “D” then press enter to make your selection.

Press space bar or the third thumb key to continue through the list.

print page numbers?  Press y for yes or n for no.  If you respond "no", print page numbers will NOT APPEAR on the printed document.  If you respond, "yes", you will be prompted

Page number position? currently, bottom center, unchanged.
To change the placement of the page number, enter 2 letters as follows:

Write “T” for top or “B” for bottom followed by the letter “L” for left, “C” for center or “R” for right.  Press enter to initiate the changes.

Continue cycling through the list, making changes to each item as necessary.

When finished, press space with “E” to exit the menu.  "Confirm changes," press Y to apply the settings for the current document or press backspace with S to apply these settings for all documents.

To restore the factory defaults, press backspace with “R”.

Print a document to be sure the formatting meets your expectations.
Lesson 23 – Using the Visual Display and the Braille Note Viewer

Braille Note Viewer Software

The Braille Note Viewer Software allows a sighted individual to view what is on the braille display using a Palm Pilot.  You must have a Palm serial cable or cradle to connect to the Braille Note through the serial port.  KeySoft version 5 supports the use of a Palm Pilot with infra-red communications.  The Braille Note Viewer software can be downloaded via e-mail or the internet into your Palm by using the software that comes with your Palm Pilot.  Most Palm Pilots on the market today come with a USB connector and have an infrared port.  

If you do not have KeySoft version 5 you will need a Palm Pilot that works with a serial cradle or cable.  Although we have not tried it, another possible solution would be to purchase a USB to serial adapter for a Palm Pilot with a USB port.  

The Braille Note Viewer is a wonderful tool when including students in regular education classrooms.  Teachers can now check the Palm Pilot to see what the braille student has written and give immediate feedback while the student is still working on a document.  WOW!!  In the days of “Full-Inclusion”, this simple device provides an unparalleled medium for non-braille readers to work with a blind student.  

Connect the Braille Note to the Palm Pilot using the serial cable.  Once the connection is secure, turn on your Braille Note.  Use the stylus to open the Braille Note Viewer Program on the Palm Pilot.  

On the Braille Note, press O with space - Options Menu 

Press V to go to the Visual Display Options – Visual Display currently off 

Press S to set it to Serial and press enter.

Main Menu should now appear on your Palm Pilot.  If nothing appears, give it a minute and try going to the Options Menu and check the power.  If nothing appears on the Palm Pilot, check your cables and try again.

Connect the Braille Note with Version 5 to the Palm Pilot using the infrared port.  Align the Palm Pilot’s infrared port with the infrared port on the Braille Note.  Use the stylus to open the Braille Note Viewer Program on the Palm Pilot.  

On the Braille Note, press O with space - Options Menu 

Press V to go to the Visual Display Options – Visual Display currently off 

Press I to set it to Infrared and press enter.

Main Menu should now appear on your Palm Pilot.  You may need to be patient initially while the connection is setting up.  Give it a minute to see if it works before you try again.  

Using a PC with the Braille Note Visual Display

In order to use the Visual Display, the software must first be copied onto your desktop from the CD that came with your Braille Note.  The icon has already been copied to the desktop as well as the start menu of the CSB laptop you might be using.  If you are using your own computer, please follow the instructions in the readme.txt file on the CD.  

Before you start the program, you must first connect the Braille Note to the laptop using the serial cable that came with your Braille Note.  Once the connection is secure, turn on your Braille Note and go to the Main Menu.

Now, on the computer, press the Window Key to open the start menu and press B to start the Braille Note Visual Display program.  

Then on the Braille Note, Press O with space - Options Menu 

Press V to go to the Visual Display Options – Visual Display currently off 

Press S to set it to Serial and press enter execute your selection.

Main Menu should now appear on your braille display as well as your computer monitor.  

The cursor does not show exact placement when using either the Visual Display and Braille Note Viewer programs.  When a student is writing contracted braille and a sentence begins with a whole word contraction, the viewer will display the whole word contraction whenever any word starts with that letter.  For example, when writing the sentence “Joan had fun.”  When the J is written the word “Just” appears in the viewer.  As soon as the O is written, the letters Jo replace the word “Just”.  

Let’s create a document with the Visual Display on.  

To create a document:

This is a review of how to create a document.  We will now create a document called Visual Display Test.

From the main menu, all six braille keys with space – main menu

Press w for the word processor key word menu
Press c to create a document folder name, press enter for ____ (your name).  Press enter to open your folder.   
If for some reason your name does not appear and you want to view the list of folders you must first press the space bar or the third thumb key and a list of folders will appear.  There are several ways to find folders in the list:

· Teachers who are sighted generally press the space bar to go through the list one folder at a time until they hear the name of the folder they want and then press enter.  The folders are listed in alphabetical order.    

· If you want to quickly go to a folder, such as the general folder, you can use first letter navigation by pressing “g” until you hear general and choose it by pressing the enter key.

· Braille display readers will likely use first letter navigation or the third thumb key to search for their folder and the enter key or the fourth thumb key to select it.  

Once you’ve selected your folder, you must now write the name of the file you wish to create.

document name? 

Write visual display test and press enter 
Top of document  - blank
Now braille the following quotes, number each one and press return between quotes:

1. Use your eyes as if tomorrow you would be stricken blind… Hear the music of voices, the song of the bird, the mighty strains of an orchestra, as if you would be stricken deaf tomorrow.  Touch each object as if tomorrow your tactile sense would fail.  Smell the perfume of the flowers, taste with relish each morsel, as if tomorrow you could never smell and taste again.  Make the most of every sense; glory in all the facets of pleasure and beauty which the world reveals to you.  

From Three Days to See, Atlantic Monthly, January 1933.

2. Use all of your senses for learning.





Chrisana, 1991

If you realize you have made a mistake, stop and use the backspace key immediately to erase your error, otherwise don’t worry about any other mistakes, you can run the spell check to find them later.  

Exit the document with an E with space to get to the keyword menu.  
Lesson 24 – Using Active Sync

ActiveSync is a Windows Utility that allows you to communicate directly from your Braille Note to the PC using a program like Windows Explorer.  Generally speaking, compact flash memory cards are the easiest way to transfer files between a PC and the Braille Note.  However, sometimes the sighted teacher or parent find it necessary to have a quick way to clean up the files on the Braille Note.  Some students in their exuberance to learn the Braille Note, read through the User’s Guide and discover the directions for backing up their files.  Backing up files is certainly an important practice.  However the key to backing up your files is to back them up on a separate source like a compact flash card.  If a student regularly backs up their files on the Flash Disk, they are simply using up their memory on the Flash Disk.  This creates quite a mess if they back their files up regularly.  It the Flash disk fails, they would lose all files.  
The ActiveSync software that comes with the Braille Note must first be installed on PC with Windows 98or higher.  If you have Version 5 Braille Note Family PC Software Version 5.0.  When you insert the disk a menu will pop up that has an option for Installing ActiveSync.  If you have an older version of the Braille Note Family of products CD follow the instructions in the readme.txt file to install ActiveSync.  Once installed 
1. First, connect the serial cable to the Braille Note and the computer.  

2. Start ActiveSync 

3. Go to the Connection Settings in the file menu – Press Alt F and then press the letter C.

4. Allow serial cable or infrared connection … will have a dotted box around it.  This option must be checked by pressing the space bar.  It must be unchecked at the end of the ActiveSync session in order to allow the Visual Display Program to work.  
5. Press Alt C to go to Get Connected.

6. The Get Connected screen comes up, do not press enter yet.  
7. On the Braille Note, go to the main menu and press U to go directly to the utilities menu.
8. Press thumb key 3 or the space bar to hear connect to active sync – do not press enter yet.
9. Now press enter on the computer Get Connected screen and immediately press enter on the Braille Note.
10. You will hear some noise and with the latest version of ActiveSync you will hear Mobile Device Connected.   Hopefully the computer will display the Set Up a Partnership screen.  Use the down arrow key to indicate no and press enter.
11. You should now be connected.
ActiveSync allows you to move, copy, or delete folders or files on the Braille Note from the PC.  To do this, you use a program called Windows Explorer.  

To start Windows Explorer on your PC, press the Window Key and the letter E to go to Explorer.  Open My Computer and you will see Mobile Device – this is the name given to the Braille Note.

Open the Mobile Device and you will either see the folders on the Braille Note or an icon with My Handheld PC.  You must open the My Handheld PC to see the folders on the Braille Note.  The Flash Disk is one of the folders listed.  Open this folder and you will see your last name as a folder listed.  That is the folder we have been working on.  

You can now move, copy or delete folders or files from this point.

Price Lists for Braille Note Accessories

Network Card

The network card is available directly from HumanWare.  

Pulse Data HumanWare

175 Mason Circle

Concord, CA 94520 

Phone (800) 722-3393  Fax (925) 681-4630 
You can also order it directly from Socketcom.com (see info below).  Many cards were tested and this particular low power Ethernet card works, please purchase this exact card.  The part number is listed below.  

http://www.socketcom.com/shop/ 

Headquarters:

37400 Central Court
Newark, CA 94560

(T) 510-744-2700
(F) 510-744-2727

On-line price quote on March 1, 2005

http://www.socketcom.com/product/EA2902-139.asp 

Ruggedized Low Power CF Ethernet Card - 
[image: image6.png]



	Online Price:
	$115.00


Part Number: EA2902-139

Ruggedized CF Ethernet Card with CF-to-PC Card Adapter 
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	Online Price:
	$129.00


Part Number: EA0914-337
Another source for the network cards, printers, compact flash cards, card readers, and PC Card Adapters is a company called The Very Last Word.  They are a certified small business.  We usually work with Shawn, he can get excellent prices on network cards, infrared printers, palm pilots and palm accessories, compact flash cards, compact flash card readers, and PC Adapter cards.  The service is exceptional and the turn around time is fast.  The infrared printers and prices are constantly changing, if you definitely want infrared capability, make certain you mention that when ordering.
Shawn Cobb.  

Sales Manager

The Very Last Word

50 E. Hamilton Ave., Suite 280

Campbell, CA 95008

Toll Free: 800-227-3993

Direct: 408-341-8803

Fax: 408-341-8808

SBE Certification#15481

FEIN:  77-0428565

Website: www.theverylastword.com
Palm Pilot Info

A Palm Pilot with a serial cable can be connected to the Braille Note and act as a visual display using the Braille Note Visual Display program that can be beamed from another Palm Pilot or e-mailed and installed using Palm Pilot Software.  
Palm Pilots on the market today all come with a USB connector but all have an infrared port.  If you are running KeySoft version 5, you will need to use the infrared port to connect to the Braille Note.  If you have an older Palm Pilot with a serial port connector, these models numbers have worked for us:

Palm Pilot M100, M105, 125

According to Palm, the Palm Pilot Serial Cable or Cradle used with the above models is also compatible with the following Palm Pilots:
i705, 
m130 
m500 
m505 
m515 
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Compact Flash Card Info
The Compact Flash Card is a separate storage card and has two main purposes for the Braille Note.  It is used for backing up files off the Braille Note Flash Disk.  It can also be used to save files such as Web Braille books, formatted Braille files, text files, Word documents … from a desktop or laptop computer that has a card reader installed or a PC card slot.  These files can then be copied to the Braille Note or read directly off the Compact Flash Card using the PC Card adapter and the slot on the right hand side of the Braille Note.
CompactFlash Card, which weighs a half ounce and is the size of a matchbook, is an ultra-small, removable data storage system. 

CompactFlash Card, available in 8, 16, 32, 48, 64, 80, 96, 128, 160, and 192MB capacities.  CF is widely used in digital cameras, PDAs, HPCs, personal communicators, medical monitors and audio recorders because it expands the functionality of those products and enables them to be smaller and lighter.  
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On-line price quote on March 1, 2005
http://www.esend.com/sandisk/products.asp?value=MECF&valueIs=dept 

SanDisk 64MB CompactFlash Card 

	Online Price:
	$19.99


Part number: SDCFB-64-768

SanDisk 128MB CompactFlash Card 

	Online Price:
	$29.99


Part number: SDCFB-128-768

PC Card Adapter Info
A compact Flash card is inserted into the PC Card Adapter which can then be popped into the Braille Note storage card slot on the right hand side of the Braille Note or into a PC Card slot on a laptop computer.

On-line price quote on March 1, 2005
http://www.esend.com/sandisk/product.asp?sku=SDAD%2D38%2DA19&mscssid=NEVAP3A9WR118K81GU3P96XXBCF4EP0B# 

SanDisk CompactFlash PC Card Adapter 

	Online Price:
	$9.99


Part number: SDAD-38-A19
[image: image12.jpg]



Compact Flash Card Reader Info

SanDisk CF Type I/II ImageMate USB

On-line price quote on March 1, 2005
http://www.esend.com/sandisk/product.asp?sku=SDDR%2D92%2DA15&mscssid=NEVAP3A9WR118K81GU3P96XXBCF4EP0B# 

Advanced Features:

-Hi-Speed USB 2.0 certified for fastest data transfer 
-Backwards compatible with all USB 1.1 ports 
-Four Models available to cover all memory card formats (including xD and Memory Stick PRO) 
-Saves batteries; let an ImageMate USB 2.0 Reader/Writer (not your portable device) transfer your files 
-Windows XP and Mac OS 10.2 logo compliant 
-Compatible with Windows 98SE, ME, 2000, XP and Macintosh OS 9.1x plus and OS X v10.1.2 Part Number: SDDR-92-A15

Online Price - $19.99
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Printer Information
The Printer market changes frequently.  A printer available today may not be available next week.  The following printers all have an infrared port and have been used successfully at CSB with the Braille Note.  Prices are estimates and what was available at the time of this printing for current prices check the Internet or Shawn Cobb at The Very Last Word – 
Toll Free: 800-227-3993

Direct: 408-341-8803

Prices are estimates and what was available at the time of this printing for current prices check the Internet or Shawn Cobb at The Very Last Word – 

Toll Free: 800-227-3993

Direct: 408-341-8803
On-line price quote on March 1, 2005
http://www.shopping.hp.com/webapp/shopping/search/search_request.do 

HP deskjet 450cbi mobile printer (C8112A#A2L) - $299.99
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Braille Note Student Progress Chart

Student’s Name: _________________________ Date: ____________________

Progress Key – M = Mastered 
P = Progressing
I=Introduced

	Lesson 1
	Braille Note Design
	Progress
	Date

	
	Student identifies and understands the function of the braille keypad
	
	

	
	Student identifies and understands the function of the backspace key
	
	

	
	Student identifies and understands the function of the return or enter key
	
	

	
	Student identifies and understands the function of the first thumb key (previous)
	
	

	
	Student identifies and understands the function of the second thumb key (back)
	
	

	
	Student identifies and understands the function of the third thumb key (Advance)
	
	

	
	Student identifies and understands the function of the fourth thumb key (Next)
	
	

	
	Student identifies and understands the function of the cursor routing keys
	
	

	
	Student identifies and understands the function of the infrared port
	
	

	
	Student identifies and understands the function of the modem port
	
	

	
	Student identifies and understands the function of the parallel port
	
	

	
	Student identifies and understands the function of the serial port
	
	

	
	Student identifies and understands the function of the power supply
	
	

	
	Student identifies and understands the function of the PCMCIA slot and eject button
	
	

	
	Student identifies and understands the function of the on/off switch
	
	

	
	Student identifies and understands the function of the reset button
	
	

	
	Student identifies and understands the function of the earphone jack
	
	

	Lesson 2
	Speech Settings
	Progress
	Date

	
	Student knows how to change the volume, pitch, and rate 
	
	

	
	Press dot 1 with the enter key for softer speech.
	
	

	
	Press dot 4 with the enter key for louder speech.
	
	

	
	Press dot 2 with the enter key for a lower pitch.
	
	

	
	Press dot 5 with the enter key for a higher pitch.
	
	

	
	Press dot 3 with the enter key for slower speech.
	
	

	
	Press dot 6 with the enter key for faster speech.
	
	

	
	Student knows how to cycle through and change the settings for Speech On, Speech on Request, Speech Off (1st thumb key plus the space bar)
	
	

	Lesson 3
	Exploring the Menus
	Progress
	Date

	
	Student can navigate through the Main Menu and is familiar with the purpose of each menu item.
	
	

	
	Student can navigate through the Sub Menus and is familiar with the purpose of each menu item.
	
	

	
	Student can navigate through the Options Menu and is familiar with the purpose of each menu item.
	
	

	Lesson 4
	Opening a Document
	Progress
	Date

	
	From the Keyword menu, the student understands how to open the last document that was used.
	
	

	
	From the Keyword menu, the student understands how to open a document that was previously written in the same folder as the current document.
	
	

	
	From the Keyword menu, the student understands how to open a document that was previously written in a different folder from the current document.
	
	

	
	From the Keyword menu, the student understands how to open a document from a different drive and folder.
	
	

	
	The student understands how to search in a forward direction for a word using the find command.
	
	

	Lesson 5
	Navigation
	Progress
	Date

	
	Student can navigate down through the menus using the third thumb key and up through the menus using the second thumb key.  
	
	

	
	Student can navigate through the menus using the space bar.  
	
	

	
	Student can select an item in the menus using the fourth thumb key.  
	
	

	
	Student can select an item in the menus using the enter key.  
	
	

	
	With space L (dots 1,2,3 w/ space) to go to the top of document
	
	

	
	With space 4,5,6 to go to the bottom of document
	
	

	
	Press With space g (dots 1,2,4,5 w/ space) to read continuously. 
	
	

	
	Stop reading by pressing the backspace with the enter key simultaneously.  The cursor will stop close to what you just heard.
	
	

	
	Reading Sentences
	
	

	
	C with space  - keeps the cursor at its present position & reads the current sentence
	
	

	
	Dot 4 with space - moves the cursor to the beginning of the next sentence & reads it
	
	

	
	Dot 1 with space - moves the cursor to the beginning of the previous sentence & reads it
	
	

	
	Reading Words
	
	

	
	Dots 2,5 with space - keeps the cursor on the present word & reads it
	
	

	
	Dot 5 with space - moves the cursor forward a word & reads it
	
	

	
	Dot 2 with space - moves the cursor backward a word & reads it
	
	

	
	Reading Characters
	
	

	
	Dots 3,6 with space - keeps the cursor on the present character & reads it
	
	

	
	Dot 6 with space - moves the cursor forward a character & reads it
	
	

	
	Dot 3 with space - moves the cursor backward a character & reads it
	
	

	
	Reading Paragraphs
	
	

	
	Dots 2,3,5,6 with space - keeps the cursor on the current word & reads the present paragraph
	
	

	
	Dot 5,6 with space - moves the cursor forward to the first cell of the next paragraph & reads it
	
	

	
	Dot 2,3 with space - moves the cursor backward to the first cell of the previous paragraph & reads it
	
	

	
	Reading With the Braille Display
	
	

	
	Er sign with space (dots 1,2,4,5,6 with the space) will scroll the entire text on the braille display.  To speed up the scrolling speed, press the thumb key 4, to slow down the scrolling speed, press the thumb key 1.
	
	

	Lesson 6
	Creating a Document
	Progress
	Date

	
	Student can go to the main menu by using the for sign with space
	
	

	
	Student can go to the word processing menu by using first letter navigation (press w from the main menu)
	
	

	
	Student can go to the create a document option by using first letter navigation (press c from the key word menu)
	
	

	
	Student can create a document, using the backspace key to make corrections as they braille.  
	
	

	
	Student can exit the document using either the e-with space or for sign.
	
	

	Lesson 7
	Easy Edit
	Progress
	Date

	
	Student can use the cursor routing keys to place the cursor one cell to the right of an incorrect letter, press the backspace to erase the incorrect letter and then immediately write the correct letter.  
	
	

	
	Student checks braille display to make certain mistake has been corrected.
	
	

	
	Student uses the backspace key to correct a mistake made while writing.  The Braille Note speaks the letter just erased.
	
	

	Lesson 8
	Printing and Embossing Documents
	Progress
	Date

	
	Student can print a document starting from either the main menu or the keyword menu.
	
	

	
	Student can go through the printer setup menu and make changes as needed. Then confirm changes with a Y command for Yes on exit. 


Paper Length 66


Paper Width 85


Use Form Feeds between pages, currently yes


Pause after each page, currently no


Page Offset, press enter for 0


Printer Port, currently parallel
	
	

	
	Student can emboss a document starting from either the main menu or the keyword menu.
	
	

	
	Student can go through the embosser setup menu and make changes as needed. Then confirm changes with a Y command for Yes on exit. 

Paper Length 25 (type a number and press enter)


Paper Width 40 (type a number and press enter)


Use Form Feeds between pages? currently no (Press Y or N, then press enter)


Pause after each page? currently no


Does your embosser emboss both sides of the page? Currently no


Page Offset? press enter for 0


Printer Port? currently parallel
	
	

	Lesson 9
	Advanced Edit
	Progress
	Date

	
	The Backspace Key can also be used in conjunction with certain dots to delete in the following manner:

Current Character - dots 3,6 with the backspace key
	
	

	
	Current Word - dots 2,5 with the backspace key
	
	

	
	Previous Word - dot 2 with the backspace key
	
	

	
	The next 3 options require an affirmative response to complete the deletion. Press Y if you are sure or N to go back to your document. 
	
	

	
	Delete to the end of the sentence - dots 1,4 with the backspace key
	
	

	
	Delete to the end of the paragraph - dots 2,3,5,6 with the backspace key
	
	

	
	Delete to the end of the document - dots 4,5,6 with the backspace key
	
	

	
	You can also delete using the deleting commands from the Delete Menu.  To get to the delete menu, press d with space (dots 1,4,5 with the space bar).  The choices are:
	
	

	
	Character, enter c for this choice and the character you are on will be deleted and you will exit the delete menu.
	
	

	
	Word, enter w for this choice
	
	

	
	Previous word, press the space bar until you hear previous word and press enter.
	
	

	
	The next 3 options require an affirmative response to complete the deletion. Press Y if you are sure or N to go back to your document.
	
	

	
	Sentence, if you press s, you will hear delete to end of sentence, sure? Press Y if you are sure or N to put you back in your document. 
	
	

	
	Paragraph, if you press p, you will hear delete to end of paragraph, sure? Press Y if you are sure or N to put you back in your document.
	
	

	
	Document, if you press d, you will hear delete to end of document, sure? Press Y if you are sure or N to put you back in your document.
	
	

	Lesson 10
	Help
	Progress
	Date

	
	Student can use the H with space (menu specific help) for help when uncertain as to what to do.  
	
	

	
	Student can use the Table of Contents in the User’s Guide to look up general information.
	
	

	
	Student can use the Index in the User’s Guide to look up specific information.
	
	

	Lesson 11
	Spell Check
	Progress
	Date

	
	The student understands how to start the spell checker to check an entire document. (ch sign with space and press D to check the entire document)
	
	

	
	Once started the student understands how to use the following spell check options:
	
	

	
	Press I to ignore all occurrences of the word.
	
	

	
	Press space with dot 5 to skip only this occurrence of the word.
	
	

	
	Press A to add the word to the spelling dictionary.
	
	

	
	Press C to enter the correct word
	
	

	
	Press L to look up a word.
	
	

	
	Press S to get a list of suggestions and scroll through the suggestions using either the space bar or the third thumb key.  Select one of the suggestions from the list by pressing the enter key or the 4th thumb key.  Press A to correct all or F to correct the first incorrect spelling. 
	
	

	
	Press C with space to hear the word in the context of the sentence and hear the misspelled word repeated after the sentence.
	
	

	
	If there are no corrections, press e-with space to exit and return to the options list.
	
	

	
	When finished using the spell checker, the student understands how to check through the document and find and correct grammar mistakes.
	
	

	Lesson 12
	Using the Planner
	Progress
	Date

	
	Student understands how to open the planner on today’s date.  At the KeyPlan menu, press O to open the planner and enter for the current date
	
	

	
	The student understands how to press the st sign with space to go to the appointment menu.
	
	

	
	The student can schedule an appointment and set an alarm for the appointment.
	
	

	
	When the power is off the student understands how to:
	
	

	
	C to cancel the alarm
	
	

	
	R to read the details of the appointment
	
	

	
	Space to postpone the alarm for 10 minutes
	
	

	
	When the power is on, the student understands how go to the alarm options menu. From the alarm options menu, the student understands how to:
	
	

	
	Read the alarm
	
	

	
	Cancel the alarm
	
	

	
	Postpone the alarm 
	
	

	
	          Go to the alarm in planner
	
	

	Lesson 18 & 19
	Copying Files
	Progress
	Date

	
	The student understands how to create a folder.
	
	

	
	The student understands how to copy a file to/from the Flash Disk to the Storage Card Slot or the Compact Flash Card Slot.
	
	

	
	The student understands how to use a multiple character wildcard to copy or delete more than one file at a time.
	
	

	Lesson 24
	Using Active Sync
	Progress
	Date

	
	The student understands how to connect the cables and run Active Sync.
	
	

	
	The student understands how to use Windows Explorer to copy, move and delete files from the Braille Note.
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